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RAE Systems Product Line 
 

§ Gas Detection Tubes & Pumps 
§ SampleRAE Electronic Tube Pump 
§ MultiRAE PLUS Multi-gas Monitors 
§ MultiRAE Confined Space Monitor 
§ QRAE PLUS Multi-gas Monitors 
§ QRAE Confined Space Monitor 
§ VRAE Five Gas Surveyor 
§ MiniRAE 2000 Portable VOC Monitor (PID) 
§ UltraRAE Specific Compound Monitor 
§ CDRAE Corona Discharge VOC Monitor 
§ ToxiRAE PLUS PID Monitor 
§ ToxiRAE PLUS Single Gas Monitors 
§ ToxiRAE PLUS Oxygen Monitor 
§ ToxiRAE PLUS Combustible Gas Monitor 
§ MiniRAE PLUS Classic PID 
§ ModuRAE Fixed System PID 
§ AreaRAE Wireless Multi-point, Multi-gas Detection 

Systems 
 
How can I be informed and updated? 

Be sure to mail in your warranty card, email or fax us to get on 
RAE’s private database (information is never supplied to others). 

You will be updated on new products, technical advisory notices, new 
accessories and much more.  Thank you for your purchase!
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! WARNING ! 
 

- DO NOT proceed before reading - 
 
This manual must be carefully read by all individuals 
who have or will have the responsibility for using, 
maintaining, or servicing this product.      
The product will perform as designed only if it is used, 
maintained, and serviced in accordance with the 
manufacturer's instructions.   
 

CAUTION!! 
To reduce the risk of electric shock, turn off power 
before removing the monitor cover.  Disconnect the 
battery before removing sensor module for service.  
Never operate the monitor while the cover is removed.  
Remove monitor cover and sensor module only in an 
area known to be non-hazardous. 
 
The model PGM-7800 and PGM-7840 equipment are 
classified as to intrinsic safety for use in class I, division 
1, groups A, B, C, D, or non-hazardous locations only. 
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Special Notes 
 

-1- 
When the PGM-7800 or PGM-7840 Multi gas monitor 
is taken out from the transport case and turned on for 
the first time, there may be some residual organic or 
inorganic vapor trapped inside the detector chamber.  
The initial toxic sensor reading may indicate a few ppm.  
Ensure an area free of toxic vapor and turn on the 
monitor.  After running for several minutes, the residual 
vapor in the detector chamber will be cleared and the 
reading should return to zero.    

-2- 
The battery of the VRAE monitor will discharge slowly 
even if it is turned off.  If the monitor has not been 
charged for 5-7 days, the battery voltage will be low.  
Therefore, it is a good practice to always charge the 
monitor before using it.  It is also recommended to fully 
charge the monitor for AT LEAST 10 HOURS before 
initial use.  See Section 7 for more information on 
battery charging and replacement. 

-3- 
When a monitor is turned on the first time, or after a 
long time without use, the real time clock of the unit 
may not work properly, error messages may indicate 
sensor expired.  That is due to the incorrect time on the 
clock.  After fully-charging the monitor, enter the 
correct time and date again to ensure that no more 
erroneous messages are displayed. 
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WARNINGS: 
Use only RAE Systems battery packs, part Nos. 012-
3050, 012-3051 or 012-3052.  This instrument has 
not been tested in an explosive gas/air atmosphere 
having an oxygen concentration greater than 21%.  
Substitution of components may impair intrinsic 
safety.  Recharge batteries only in non-hazardous 
locations. 
 

 
 

AVERTISSEMENT: 
Utiliser seulement l'ensemble de batterie RAE 
Systems, la reference 012-3050, 012-3051 au 012-
3052.  Cet instrument n’a pas été essayé dans une 
atmosphère de gaz/air explosive ayant une 
concentration d’oxygène plus élevée que 21%.  La 
substitution de composants puet compromettre la 
sécurité intrinsique.  Ne charger les batteries que 
dans emplacements désignés non dangereux. 
 

 

STATIC HAZARD: 
Clean only with a damp cloth. 
 

DANGER RISQUE D'ORIGINE 
ELECTROSTATIQUE: 

Nettoyer uniquement avec un chiffon humide. 
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CAUTION: 
For safety reasons this equipment must be operated 
and serviced by qualified personnel only. Read and 
understand instruction manual completely before 
operating or servicing. 

 
ATTENTION: 

Pour des raisons de sécurité, cet équipment doit être 
utilisé, entretenu et réparé uniquement par un 
personnel qualifié.  Étudier le manuel d’instructions 
en entier avant d’utiliser, d’entretenir ou de réparer 
l’équipement. 
 

 
 

CALIBRATION WARNINGS: 
 

The calibration of all newly purchased RAE Systems 
instruments should be tested by exposing the 
sensor(s) to known concentration calibration gas(es) 
before putting the unit into service for the first time. 
 

For maximum safety, the accuracy of the VRAE 
should be checked by exposing the sensor(s) to known 
concentration calibration gas(es) before each day’s 
use. 
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AVERTISSEMENT: 
La calibration de toute instruments de RAE Systems 
doivent être testé en exposant l’instrument a une 
concentration de gaz connue par une procédure 
dietalonnage avant de mettre en service l’instrument 
pour la première fois.  
 
Pour une securite maximale, la sensibilité du VRAE 
doit être verifi er en exposant l’instrument a une 
concentration de gaz connue par une procédure 
dietalonnage avant chaque utilisation journalière.  
 

 
 

 

CAUTION: 
Any rapid up-scale reading followed by a declining or 
erratic reading may indicate a gas concentration 
above the upper scale limit, which may be hazardous. 
 

 
 

AVERTISSEMENT: 
Toute lecture rapide et positive, suivie d’une baisse 
subite au erratique de la valeur, peut indiquer une 
concentration de gaz hors gamme de détection qui 
peut être dangereuse. 
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1  GENERAL INFORMATION 

The VRAE is a programmable multi gas monitor designed to 
provide continuous exposure monitoring of toxic gases, 
oxygen and combustible gases for workers in hazardous 
environments.  Two models of VRAE are available: PGM-
7800 and PGM-7840.  The PGM-7840 has one more 
inorganic toxic sensor in lieu of an oxygen sensor in the 
PGM-7800. The figures and displays shown in this 
manual are primarily for the model PGM-7800.  For 
the model PGM-7840, the displays will be similar. 
However, the oxygen reading will be replaced by a toxic 
sensor reading, and the name “oxy” will be replaced by 
the name of the toxic sensor. 
 
The VRAE monitor detects inorganic toxic gases and 
oxygen concentration with the electrochemical sensors.  It 
also monitors combustible gases with a catalytic bead 
sensor and a broad range of gases with a thermal 
conductivity detector.  Other features include:   
 
•  Lightweight and Compact  
 - 19 oz (540 g), walkie–talkie size. 
 

•  Dependable and Accurate 
 - 10 hours monitoring with micro-controller. 
 

•  User Friendly 
 - Menu driven, intuitive end-use operation. 
 

•  Programmable Alarm Thresholds  
 - Audio buzzer & flashing display alarm. 
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1.1 General Specifications 
Table 1.1 

VRAE Gas Monitor Specification 
Dimensions: 7.75”L x 2.75”W x 1.5”H 
 (19.6 cm x 7.0 cm x 3.8 cm)   

Weight: 19 oz (540 g) with battery. 
 

Detector: 5 sensors: electrochemical sensors for 
toxic gases, oxygen sensor, catalytic bead 
for combustible gases and thermal 
conductivity detector (TCD) for a broad 
range of gases. 

 PGM-7800:  oxygen, combustible, TCD 
and three toxic gas sensors. 

 PGM-7840:  one combustible/TCD and 
four toxic gas sensors. 

 

Battery: Rechargeable, 4.8V/1250 mAh, Ni-MH 
battery pack with built-in charger  (10 
hours charge time) or a 4 AA alkaline 
battery adapter. 

 

Operating Time: Up to 10 hours continuous operation.  

 

Display: 2-line, 16 digit LCD with LED back light 
automatically in dim light. 

 

Keypad: 1 operation key and 2 programming keys. 
 

Direct Readout: Instantaneous values (up to 5), sensor 
name, high and low values for all detectors, 
TWA and STEL values for toxic, battery 
voltage and elapsed time. 
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Multi Gas Monitor Specification 
(Continued) 

Alarm Settings: Separate alarm limit settings for TWA, 
STEL, Low and High alarm.  

Range, Resolution and Response Time (t90 diffusion):  
  CO 0-500 ppm 1 ppm     40 sec 
  H2S 0-100 ppm 1 ppm     35 sec 
  SO2 0-20 ppm      0.1 ppm   35 sec 
  NO 0-250 ppm 1 ppm     30 sec 
  NO2 0-20 ppm      0.1 ppm   25 sec 
  Cl2 0-10 ppm      0.1 ppm   60 sec 
  O2  0-30 %          0.1 %     15 sec 
  LEL 0-100 % 1 %     15 sec 
  VOL 0–100% 1%     20 sec 
  HCN 0-100 ppm 1 ppm    200 sec 
 NH3 0-50 ppm 1 ppm   150 sec 
 PH3 0-5 ppm       0.1 ppm    60 sec 
  ClO2 0-1 ppm      0.1 ppm   150 sec 
 
 

Alarm: 90 dB buzzer and flashing red LED to 
indicate exceeded preset limits, low 
battery, or sensor failure. 

 

Calibration: Two-point field calibration for fresh air 
and standard reference gas. 

 

Attachment: Rubber boot, belt clip and wrist strap. 
 

Sampling Pump: Internal integrated with 400 cc/min flow 
rate (high setting). 

 

Protection: Password protected calibration settings, 
alarm limits, and data. 
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Multi Gas Monitor Specification 
(Continued) 

Intrinsic Safety: UL & cUL Class 1, Division I, Group A, B, 
C, D (US & Canada), EEx ia IIC T2 
(Europe). 

 

EM Immunity: No effect when exposed to 0.43mW /cm2 
RF interference (5 watt transmitter at 12 
inches). 

 

Data Storage: 16,000 readings (54 hours, 5 channels at 1 
minute interval) in non-volatile memory.  

 

Datalog Interval: Programmable 1-3600 sec. 
 

External Alarm: Optional plug in pen size vibration alarm. 
 
External Printer:  Optional plug in serial thermal printer. 
 

Communication: Download data to PC and upload monitor 
setup from PC through RS-232 link to 
serial port on PC. 

 

Temperature: -20o to 45oC (-4o to 113o F).  
 

Humidity: 0 % to 95% relative humidity. 
  (non-condensing) 
 

Configuration: 2, 3, 4 and 5 gas with/without  
  datalogging. 
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2 OPERATION OF VRAE 
 
 
The VRAE Monitor is a walkie-talkie size multi-gas 
exposure monitor.  It gives real time measurements and 
activates alarm signals whenever the exposure exceeds 
preset limits.  Prior to factory shipment, the VRAE is preset 
with default alarm limits and the sensors are pre-calibrated 
with standard calibration gas.  However, the user should 
calibrate the instrument before the first use.  After the 
monitor is fully charged and calibrated, it is ready for 
immediate operation.  
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2.1 Physical Description 
 
Figure 2.1 shows the main components of the VRAE Multi 
gas monitor which include: 
 
 

 
Figure 2.1   Major parts of the VRAE Multi Gas 

 Monitor 
 
• 3 keys for the user to interact with the monitor:  1 

operation key and 2 programming keys for normal 
operation or programming of the monitor.  

 
• LCD display with backlight to show real time and 

calculated measurements. 
 
• Buzzer and red LED for alarm signal whenever the 

exposures exceed preset limits. 
 
• Wrist strap. 

Charge contact 

Keys 

LCD Display 
LED alarm 

Serial port 

Wrist strap 

Gas Outlet 

Gas Inlet 
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• Charge contact for plugging directly to the charging 

station. 
 
• Gas entry and exit port.  
 
• Serial communication port for PC interface.  
 
• Analog output and external alarm output port.  
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2.2 Keys and Display 

 
Figure 2.2 shows the LCD display and the keypad on the 
front panel of the monitor.  The functions of the 3 keys 
during normal operation are summarized in Table 2.1 on the 
next page: 

 

 
Figure 2.2   Keypad and Display of the VRAE 

          Multi Gas Monitor 
 
 
 

MODE
N/-Y/+ ON

Charging LED Light Sensor Alarm LED 
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   Table 2.1 
Key  Function in Normal Operation 
 

[MODE]:  Turn on/off the power* and choose 
    different display mode. 
 
[N/-]:   Toggle on/off the backlight. 
 
[Y/+]:  Alarm test and alarm acknowledge  
  (turn off latched alarm, turn on pump or 
   LEL sensor). 

 
 
* Pressing and holding [MODE] key for 5 seconds turns off 
the power to the monitor.  Monitor will beep once per 
second during power-down sequence.  Press [MODE] key 
momentarily to choose different display modes (see Section 
2.4 for details). 
 
 
Display 
The VRAE multi gas monitor includes a 2-line, 16-digit dot 
matrix LCD display.  The LCD shows the following eight 
types of displays during normal operation if the [MODE] key 
is pressed: 
 
• Real time instantaneous gas concentration in ppm for 

toxic gases, % by volume for oxygen (not applicable 
to PGM-7840) and both % by volume and %LEL for 
combustible gases.  

•  Sensor names. 
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•  Peak and minimum gas concentrations for toxic, 
oxygen (not applicable to PGM-7840) and 
combustible gases. 

 
•  8-hour Time Weighted Average (TWA) or running 

average and 15 minute Short Term Exposure Limit 
(STEL) values of the toxic gases in ppm. 

 
• Battery voltage and shut down voltage in volts. 
 
• Real time clock, run time and temperature. 
 
• Datalogging mode or “Start/Stop Datalog?” menu to 

to turn datalogging on/off if manual datalogging mode 
is selected. 

 
• LEL/VOL gas names (if the LEL or LEL/VOL sensor 

is installed).  
 
• Pump speed adjustment (High/Low) 
 
• LEL/VOL sensor operating mode selection. 
 
• “Communicate with PC?” menu to send or receive 

data between PC and the VRAE monitor.   
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2.3 Power On/Off 
 

To turn on the VRAE multi gas monitor, press the [MODE] 
key. The audio buzzer will beep once and the display will 
show “ON!..” and then “MultiGas Monitor Ver n.nn” to 
indicate the software version number. Serial number, current 
date and time, temperature of the monitor are displayed next.  
The monitor will then go through each sensor socket to 
check if a valid sensor is installed.  If a new sensor is 
installed, a message to remind the user to calibrate the 
sensor will be displayed followed by a message that the 
alarm limits have been reset to default values for the new 
sensor.  If a sensor reaches its expected end of life, a 
“Warranty Expired” message will be displayed. The sensor 
can be used beyond this date if it still calibrates properly and 
has enough resolution as tested by the raw readings (see 
Section 8 and Technical Note 123). 
 

Next, the monitor displays the preset alarm limits for each 
sensor, battery voltage, shut down voltage, user mode, alarm 
mode, datalog mode, available data storage memory (in 
hours), datalog mode and datalog interval (in seconds).  Then 
after a warm-up interval (default of 10 seconds), the VRAE 
monitor is ready to monitor gases, and the display shows the 
instantaneous reading of the gas concentration in ppm. 
 
To turn off the VRAE multi gas monitor, press and hold the 
[MODE] key for 5 seconds.  The monitor will beep once per 
second during the power-down sequence with a count down 
timer showing the number of remaining seconds.  The 
message “Off!..” flashes on the LCD display and the display 
will go blank, indicating that the monitor is turned off.   
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Turning off the multi gas monitor with the AC adapter in 
place will result in a display of “Charging..” or “Battery 
Charged” and indication of battery voltage.  This indicates 
that the monitor is off, but the smart charger circuit is now 
active. 

To turn the unit on from the charge or discharge mode, press 
the [MODE] key. 

Data protection during power off  

When the monitor is turned off, all the current real time data 
including TWA, STEL, Peak and elapsed time are erased.  
However, the datalog data is preserved in non-volatile 
memory.  Even if the battery is disconnected, the datalog 
data will not be lost.  During the power off period, the real 
time clock will continue to operate until the battery is 
completely drained (usually in 5-7 days without any 
charging).  If the battery is completely drained or is 
disconnected from the monitor for more than 30 minutes, 
the real time clock will be lost.  In this case, the user needs 
to enter the real time clock information again, as described 
in Section 4. 

Datalog versus Non Datalog monitor 

The VRAE multi-gas monitor is available either with or 
without the Datalog option.  During the power on sequence, 
a letter “D” following the version number indicates that the 
monitor is configured as a Datalog monitor.  Without the 
letter “D”, it is a Non-Datalog monitor. 

The user can upgrade a Non-Datalog monitor to a Datalog 
monitor.  Call the factory for information on how to order 
the upgrade kit. 
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For instructions and operations of datalog features, please 
refer to Sections 4.6 and 5 of this manual. 

 



OPERATION OF VRAE 
 

2 - 10 

2.4 Operations 

The VRAE multi gas monitor offers three different user 
modes of operation: 

 Text mode, 
 Display mode, and 
 Program mode. 

The text mode is the simplest mode of operation.  The 
monitor will display the sensor name after the monitor is 
turned on.  The user can press the [MODE] key to see the 
instantaneous gas concentration readings, battery voltage or 
enter the PC communication menu.  

The display sequence in text mode.  
The four displays are arranged in a “round robin” order: 
 
 

 

 

 

To choose a specific display, press the [MODE] key one or 
more times until the desired display appears. 

In the display mode, the VRAE multi gas monitor displays 
eight different readings: instantaneous gas concentration, 
sensor name, Peak, minimum, STEL, TWA, battery voltage 
and shut down voltage in volt, run time in hours and minutes 
and temperature in degree F.  In addition, there are up to five 
more displays to show datalog mode (or enable / disable 
datalogging operation in manual datalog mode), to show the 

Sensor Names
  

Comm with 
PC? 

 Instantaneous 

Battery Voltage 
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LEL gas names, to show pump speed, and to print reading 
(Option) and to communicate with a PC. 

In the program mode, the user can perform all of the 
functions of the display mode.  In addition, the user can 
enter a Programming Mode.  In the programming mode, 
the user can perform various functions, such as change 
sensor configurations, enter user information or calibrate 
the monitor, etc.  The programming mode will be explained 
in detail in Section 4.  Below is the display sequence in 
display and program mode. 

The thirteen displays are arranged in a “round robin” order: 
 

 

 

 

 

 

 

* Appears only if the option is enabled. 

To choose a specific display, press the [MODE] key one or 
more times until the desired display appears.   

Run time, Clock 
Temperature 

Instantaneous 

Min. Value 

Comm with PC? 

Peak Value 

LEL Gas Name STEL Value 

Sensor Name 

Start/Stop Dlog?* 

Battery Voltage 

TWA Value 

Pump Speed H/L 

Print Reading?* 
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The followings are the brief explanations of each LCD 
display in the text mode or the display mode operation for 
the model PGM-7800.  For the model PGM-7840, the 
displays will be similar.  However, the oxygen reading 
will be replaced by a toxic sensor reading, and the name 
“oxy” will be replaced by the name of the toxic sensor. 
 
 

1) The instantaneous reading is the actual gas 
concentration in parts per million (ppm) for toxic gases, 
% of volume for oxygen and % of volume or % of LEL 
for combustible gases.  The reading is updated once per 
second and is shown in the LCD display. 

                    
 

   0       0.0       0 

   0     20.9 
           

2)  The sensor names are displayed as:  
 LEL:  For combustible gas sensor 
 OXY:  For oxygen sensor (not for PGM-7840) 

CO, H2S, etc.:  For up to 3 toxic sensors (4 for PGM-
7840) 
 

  

CO      SO2  H2S 

LEL     OXY 

 
3) The Peak reading is the highest reading of each gas 

concentration since the monitor was turned on.  The 
reading is updated at one-second intervals and is shown 
in the LCD display with “PEAK” message. 
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5       2.0       3 

10     PEAK 20.9 

 
4) The Minimum reading is the lowest reading of each gas 

concentration since the monitor was turned on.  The 
reading is updated at one-second intervals and is shown 
in the LCD display with “MIN” message. 

 
 

0       0.0       0 

0       MIN 19.9 

 

5) The STEL reading is the last 15-minute average reading 
of the gas concentration.  The reading is updated once 
per minute and is shown in the LCD display with “STEL” 
message.  For the first 15 minutes, “****” will be 
displayed.  This reading applies to toxic gases only.  The 
model PGM-7840 will have one more reading displayed 
on the right of the “STEL”. 

 
 

0       0.0       0 

     STEL   

6) The TWA reading is the accumulated reading of the gas 
concentration divided by 8 hours since the monitor was 
turned on.  The reading is updated once a minute and is 
shown in the LCD display with “TWA” message.  This 
reading applies to toxic gases only.  The model PGM-
7840 will have one more reading displayed on the right 
of the “TWA” or “AVG”. 
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0       0.0       0 

     TWA   
 

The user can also choose to display “running average”, 
instead of the TWA.  See Section 4 for details on how to 
select running average or TWA.  When running average is 
selected, the LCD display will show “AVG”, instead of 
“TWA”. 
 

0       0.0       0 

     AVG   

 
7) The battery voltage reading is the current battery 

voltage in volts.  The reading is updated once per second 
and is shown in the LCD display.  The shut down voltage 
is also shown.  Note: a fully charged battery pack should 
show 4.8 volts or higher.  When the battery voltage falls 
below 4.4 volts, a flashing “Bat” will appear as a warning 
message, plus a buzzer alarms every second.  This means 
there is 20-30 minutes run time left before the monitor 
will be turned off automatically, when the battery 
voltage falls below 4.2 volts.  

 
 

Battery = 4.8 V 

Shut off at 4.2 V 

8) The run time reading is the accumulated “On” time in 
hours and minutes since the monitor was turned on.  The 
reading is updated at one-minute intervals and is shown in 
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the LCD display together with the current date, time and 
temperature. 

 
 

8/3/96       8:30 

On = 3:50          20°C 
 

9) The datalog menu shows the current datalog mode.  If 
the VRAE monitor is non-datalog monitor, this menu 
will not show up.  If manual datalog mode is selected, the 
menu will prompt the user to turn on or off datalogging.  
Pressing the [Y/+] key while “Start Datalog?” message is 
displayed turns on the datalogging.  Likewise, pressing 
the [Y/+] key while “Stop Datalog?” message is displayed 
turns off the datalogging.  

 
10)The monitor displays the selected LEL gas name if the 

combustible sensor is installed.  When an LEL gas is 
selected, the “calculated” gas concentration based on the 
built-in correction factor for that specific gas will be 
displayed. 

 
11)The monitor displays pump speed “High” or “Low.”  

Press [Y/+] key to accept the displayed speed.  Press 
[N/–] key to toggle to the other speed.  

 
12)From the LEL/VOL menu the user can select the 

operating mode of the LEL/TC sensor: “LEL”, “VOL”, or 
“Autorange”. See Section 4.8 for more details. 
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13) If the serial printer option is enabled through the Pro-
RAE suites, a new menu item is shown “Print Reading?”  
Connect a Rae specified serial printer to the serial port 
of the monitor.  By pressing the “Y” key, the current 
instantaneous readings of the monitor will be printed out 
from the serial printer. 

 
14)The communicate with PC? menu display allows the 

user to upload data from the VRAE to a Personal 
Computer (PC) or download configuration information 
from a PC to the VRAE.   

 
Press the [Y/+] key and the LCD displays the message 
“Monitor will pause, OK?” to remind the users that during 
PC communication, there will be no real time monitoring of 
the gas concentration.  Press [Y/+] key to proceed and the 
monitor enter the communication standby mode.  The LCD 
then displays “Ready...”  Connect the monitor to the serial 
port of a PC.  The monitor is then ready to receive any 
command from PC (see Section 5 for details on 
communications between VRAE and PC). 
 
 
Note:  When the monitor is in communication 
standby mode, it stops monitoring the gas 
concentration and stops datalogging.  Datalogging 
must be manually restarted when exiting the 
communication standby mode, unless it is in 
automatic datalogging mode. 
  
Press the [MODE] or [N/-] key to exit the communication 
standby mode and move to the next display, which shows 
instantaneous readings.  



OPERATION OF VRAE 
 

2 - 17 

 

Display time out  

In all displays, the LCD will automatically return to the 
instantaneous reading (in display or program mode) or 
sensor name (in text mode) after a one-minute timeout 
interval if no key is pressed. 
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2.5 Alarm Signals 
 
The built-in microcomputer constantly updates and monitors 
gas concentration and compares it with the programmed 
alarm limits (TWA, STEL, and two instantaneous alarm 
limits:  Low & High).  Whenever the concentration exceeds 
any of the preset limits, the loud buzzer and red flashing 
LED are activated immediately to warn the user of the alarm 
condition. 
 
In addition, the VRAE will alarm if any of the following 
condition occurs: battery voltage falls below a pre-set 
voltage level (4.4 V), LEL sensor is off, pump stalls, reading 
is over range or when datalog memory is full.  When the low 
battery alarm occurs, there will be approximately 20-30 
minutes of operating time remaining.  When the battery 
voltage falls below 4.2 V, the monitor will be turned off 
automatically. 
 
Alarm Signal Disabled:  It is extremely important to 
note that during the following conditions, the alarm 
signals are disabled: 
1) When entering PC communication standby 

mode.  
2) When entering Calibration mode. 
3) When viewing data in datalog. 
4) When printing data to serial printer.  (Short 

moment) 
During these modes of operation, real time monitoring of 
the gas concentration stops.  None of the gas concentrations 
will be calculated, including Peak, STEL and TWA. 
Alarm Signal Latching: 
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It is possible to setup the VRAE from a PC or in 
programming mode so that when an alarm condition occurs, 
the alarm signals stay on even after the alarm condition is no 
longer present.  This is called the “latching alarm” mode.  
The alternative mode is to automatically reset the alarm 
signal when the alarm condition is cleared.  The default 
alarm mode is automatic reset (see Section 4 and Section 5 
for details on how to set alarm mode). 
 
Alarm Signal Summary: 

The various alarm signals are summarized here: 
 

Condition Alarm Signal 
Gas exceeds “High 
Alarm” limit 

3 beeps/flashes per second 
plus sensor name and “High” 
message on LCD 

Gas exceeds “Low 
Alarm” limit 

2 beeps/flashes per second 
plus sensor name and “Low” 
message on LCD 

Gas exceeds STEL 1 beep/flash per second plus 
sensor name and “STEL” 
message on LCD 

Gas exceeds TWA 1 beep/flash per second plus 
sensor name and “TWA” 
message on LCD 

Instrument max out 
or sensor over range 

3 beeps/flashes per second 
plus sensor name and MAX or 
OVR message on LCD 

Excessive negative 
sensor drift 

1 beeps/flashes per second 
plus sensor name and NEG 
message on LCD 
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Pump failure 2 beeps/flash per second plus 
“Pump” message on LCD 

LEL sensor off 3 beeps/flash per second plus 
LEL sensor name and “Off” 
message on LCD 

Low battery 1 flash per second, 1 beep per 
minute plus “Bat” message on 
LCD  

Memory full 1 flash per second plus “Mem” 
message on LCD  

 

Alarm Signal Testing: 

Under normal non-alarm conditions, it is possible to test the 
VRAE LED, buzzer and back light by pressing the [Y/+] key 
momentarily.  The buzzer beeps once and the LED and back 
light flashes once to indicate that these alarm signals are 
functioning correctly.  
 

 

WARNING: 
 

The alarm signals are disabled during PC 
communication, calibration or datalog review 
operation.  To reduce the risk of exposure to 
hazardous atmospheres, perform PC 
communication, calibration or datalog review only 
in area known to be non-hazardous. 
 



OPERATION OF VRAE 
 

2 - 21 

2.6 Back Light 
 
The LCD display is equipped with an LED back light to assist 
in reading the display under poor lighting conditions.  In 
manual mode, this back light can be turned on manually by 
pressing and holding the [N/-] key for one second in normal 
operation.  The back light can be turned off by pressing [N/-] 
a second time.  If the [N/-] key is not pressed, the back light 
will be turned off automatically after a pre-programmed 
time-out period to save power. 
 

In automatic mode, the ambient light is sensed and the back 
light will be turned on automatically if the ambient light is 
below a threshold level.  The back light will be turned off 
automatically when the ambient light exceeds the threshold 
level.  
 
(See Section 4 and Section 5 for details on how to set back 
light mode and time out period from the monitor or from 
PC.  See Section 8 for details on how to set the ambient 
light threshold level.) 
 
Note:  The LED back light consumes a higher amount of 
energy from the battery and shortens the operating time of 
the monitor by 20 - 30%.   
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2.7 Preset Alarm Limits and Calibration 
 
The VRAE Multi gas monitor is factory calibrated with 
standard calibration gas, and is programmed with default 
alarm limits as listed below.  Refer to Section 4 for 
programming procedures if new calibrations or alarm limits 
are required.  
 

Table 2.2 
Factory Calibration and Preset Alarm Limits   
Gas   
ppm 

Cal Gas / 
Balance 

Unit TWA      STEL Low High 

CO 50 / Air ppm 35 100 35 200 
H2S 25 / N2 ppm 10 15 10 20 
SO2 5 / N2 ppm 2 5 2 10 
NO 25 / N2 ppm 25 25 25 50 
NO2 5 / Air ppm 1 1 1 10 
Cl2 10 / N2 ppm 0.5 1 0.5 5 
O2 20.9 / N2 % - - 19.5 23.5 
CH4 50 / Air %LEL - - 10 20 
CH4 20 / N2 %Vol - - 10 20 
HCN 10 / N2 ppm 5 5 5 50 
NH3 50 / N2  ppm 25 35 25 50 
PH3 5 / N2 ppm 0.3 1 1 2 
ClO2 0.5/Air ppm 0.1 0.3 0.2 0.5 
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2.8 Integrated Sampling Pump 
 

The VRAE multi gas monitor includes an integrated 
sampling pump.  This is a diaphragm pump providing 400 cc 
per minute flow rate at the high setting.  Connecting a 1/4 
inch Tygon tubing with 1/8 inch inside diameter to the gas 
inlet port of the VRAE, this pump can pull in air samples 
from 200 feet away horizontally, or 90 feet vertically (see 
Technical Note 140 for tubing volumes and delay times). 
 

A low pump speed is the factory default setting, which will 
reduce the flow rate by about 25%, and increase battery life 
by about 5%, and result in an increased LEL sensor lifetime.  
The low speed is the default setting, so to achieve the high 
speed performance, this needs to be switched to high (see 
Section 4.7 for details of how to select the pump speed). 
 

A high pump speed is required when measuring certain gases 
in order to reduce the absorption of these gases by the 
materials in the gas passage.  These gases include: Cl2, ClO2, 
PH3, NH3, and HCN.   
 

If liquid or other objects are sucked into the water trap in the 
inlet port and cause the pump to stall, the electronics of the 
monitor will detect the obstruction and shut down the pump 
immediately.  The alarm will be activated and a flashing error 
message “Pump” will be displayed in the LCD display.  The 
user needs to acknowledge the pump shut off condition by 
pressing the [Y/+] key to re-start the pump. 
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2.9 Datalogging  
This function is not applicable to non-datalog monitor. 
 
The VRAE Multi gas monitor calculates and stores the gas 
readings based on user-specified datalogging period and the 
type of measurement.  Two types of gas measurements, 
average or peak concentration, can be stored for each sensor 
during each datalogging interval.  The datalogging interval 
can be programmed from one second to 60 minutes in one 
second increment.  In addition, time stamp, user ID, site ID, 
serial number, last calibration date, and alarm limits are also 
stored.  All data is retained in non-volatile memory so that it 
can be downloaded at a later time to a PC.   
 
Start/stop datalog  
There are four ways to initiate the datalog operation:   
- automatic: start and stop datalogging automatically when 

the monitor is turned on and off. 
- manual: start and stop datalogging by pressing a key 

manually.  
- periodic: start and stop datalogging daily based on preset 

time (hour and minute). 
- schedule: start and stop datalogging based on preset date 

and time (month, date, hour and minute). 
 
Program datalog option 
Most of the datalogging options can be programmed from 
the monitor.  Additional options can be programmed using a 
PC and down loaded to the monitor (see Section 5 for 
details on how to program various datalogging options). 
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Start/stop datalogging manually 
If manual datalogging mode has been selected from the 
normal operation menu, toggle through the menu using the 
[MODE] key until the “Start Datalog?” prompt is 
displayed.  Pressing the [Y/+] key turns on datalogging.  
Likewise, pressing the [Y/+] key while “Stop Datalog?” is 
displayed, turns off datalogging. 
 
The other three modes of datalogging will start and stop 
automatically without any user intervention: 
 
Automatic Datalogging 
Datalogging is automatically started when the monitor is 
turned on. 
 
Scheduled Start/Stop Datalogging 
Data logging starts at a specific date and time, and logs data 
at the specified “data logging period.”  When the “stop date 
and time” is reached, the monitor stops datalogging.  This 
mode requires that the monitor be turned on first before the 
datalogging can start. 
 
Periodic Start/Stop Datalogging 
Data logging starts daily at a specific time, and logs data at 
the specified “data logging period.”  When the “stop time” is 
reached, the monitor stops datalogging.  This mode requires 
that the monitor be turned on first before the datalogging can 
start. 
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Datalogging event 
Each time a datalogging operation is initiated, a datalog 
event is created.  Information, such as start time, datalogging 
period, alarm limits, etc. will be recorded in the event 
header, followed by the measurement data.   
 

Datalogging pause 
Under the following conditions, the datalogging will be 
paused automatically: 
 
1) When entering programming mode, datalogging will   
stop.  Upon exiting the programming mode, the datalogging 
will resume. 
 
2) When entering PC Communication standby mode, 
datalogging will stop.  Upon exiting the PC communication 
standby mode, datalogging will resume only if datalogging 
mode was set to automatic mode.  
 
3) When printing data to serial printer. 
 
In either case, a new datalog event will be created when the 
datalogging is resumed. 
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3 OPERATION OF ACCESSORIES 
 
The accessories for VRAE include: 
 
• Battery Charger  
 
• Alkaline Battery Adapter  
 
• Water Trap Filter 
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3.1 Battery Charging Operation    

 
The charging circuit of the VRAE is built into the monitor.  
It only needs a regular AC to 12V DC adapter (wall mount 
transformer) to charge the monitor. 
 
1. Connect the AC adapter (or the optional automotive 

charging adapter) to the DC jack on the VRAE monitor. 
 
1. The display will ask whether a discharge cycle (see 

NOTE on next page) is required, press [N/-] key, and the 
charging function will begin.  If a key is not pressed 
within ten seconds, the charging will begin automatically.  
The display will show: 

 

Charging 

Battery = 5.6V 

 

3. The charging LED should be red in color when charging.  
If the battery is fully charged, the LED will change from 
red to green.  The red color indicates that the battery is 
being fast charged.  The green color indicates that the 
battery is fully charged.  The display will also indicate 
“Fully charged”.  A completely discharged VRAE monitor 
will be charged to full capacity within 10 hours.  
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NOTE:  If a Ni-Cd battery is used, perform occasional deep 
discharge to the battery to maintain full capacity.  The deep 
discharge cycle can be done proceeding a charge cycle by 
powering the unit with the AC adapter.  The display will 
prompt: Deep Discharge?  Press the [Y/+] key.  The charge 
cycle will automatically follow.  The deep discharge is 
useful to remove memory effects from the Ni-CD battery so 
that the charge capacity is maintained.  For Ni-MH battery, 
there is no need to perform this deep discharge operation. 

Note:  With the smart charging circuitry, a maximum charge 
time is imposed, so removing the charger is not necessary. 
 
The battery of the VRAE monitor will be drained slowly 
even if the monitor is turned off.  If the monitor has not been 
charged for 5-7 days, the battery voltage will be low.  
 
The factory-supplied battery is designed to last for 10 hours 
of normal operation (no alarm, no back light condition) for a 
new battery under the best condition.  As the battery 
becomes older or is subject to adverse conditions (such as 
cold ambient temperature), the battery capacity will be 
reduced significantly.  
 

When the monitor is on and the AC adapter is plugged in, the 
smart charging circuitry will constantly apply charge current.  
To use the smart charging function, turn off the monitor 
first, and then apply the AC adapter.  
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WARNING: 
 

To reduce the risk of ignition of hazardous 
atmospheres, recharge battery only in area 
known to be non-hazardous.  Remove and 
replace battery only in area known to be non-
hazardous.  
 

Ne charger les batteries que dans emplacements 
designes  non-dangereux. 
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3.2 Alkaline Battery Adapter 

An alkaline battery adapter is supplied with each VRAE kit.  
It accepts four AA size alkaline batteries and can be used in 
place of the NiMH battery pack to provide approximately 
12-14 hours of operation.  The adapter is intended to be used 
in emergency situations when there is no time to charge the 
NiMH battery. 

Figure 3.2   Alkaline Battery Adapter 
 
To install the adapter, remove the cover of the monitor.  
remove the NiMH battery pack from the battery 
compartment and place the alkaline battery adapter into the 
battery compartment. 

The internal charging circuit will automatically detect the 
alkaline battery adapter and prevent charging of the battery. 
Note:  The AA Alkaline battery adapter supplied by 
RAE Systems Inc. is intrinsically safe!  

Battery Housing 

Battery Housing Cover 
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3.3 Water Trap Filter 

The water trap filter is made of PTFE (Teflon) membrane 
with a 0.2 micron pore size to prevent water from being 
sucked into the sensor manifold, which would cause 
extensive damage to the monitor.  It will also remove any 
dust and other particles from entering the monitor and 
prolong the operating life of the sensor. 
 
To install the water trap filter, simply insert the water trap 
into the front of the inlet probe. 

 
Some gases such as Cl2, ClO2, PH3, NH3, and HCN could 
react with filtered particles or water or be absorbed by the 
water trap housing material.  In these cases, the water trap 
filter can be removed.  If the filter is not used, extra care 
should be taken not to draw liquids into the unit, and it may 
be necessary to maintain the pump more frequently. 
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4 PROGRAMMING OF VRAE  
 
The VRAE Monitor is built with a microcomputer to provide 
programming flexibility for the user.  Authorized users can 
re-calibrate the monitor, change the alarm limits, change site 
ID, user ID, datalogging period, real time clock, etc. 
 
Programming is menu-driven to provide intuitive end-user 
operation.  The display shows the menu options, and the key 
pad is used for menu selection and data entry. 
 
Note:  The real time monitoring of the gas 
concentration continues while in the programming 
mode.  However, during the calibration or review 
datalog procedures, the real time monitoring will 
pause until the procedures are completed.  In 
addition, entering programming mode will pause the 
datalogging operation automatically.  After exiting 
programming mode, datalogging operation will 
resume.   
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4.1  Programming Mode 
 
The VRAE has three user modes:  text, display and 
program mode.  The user can access the programming 
mode menu only if they are in the program mode (or from 
text mode with password).  If the monitor is set to display 
mode, the user cannot enter the programming mode.  In this 
case, the user mode can be changed only through a PC (see 
Section 5.0 for details on setting up the user mode). 
  
The programming mode allows the users to change the 
setup in the monitor, calibrate the monitor, modify the 
sensor configuration and enter user information, etc.  The 
programming functions are organized in a three tiers menu 
structure.  Table 4.1 shows the first tier of the programming 
menu.  Each menu item includes several sub-menus to 
perform additional programming functions.  Appendix A 
shows a more detailed menu tree structure. 
  
   Table 4.1 

 Programming Menu  
Calibrate Monitor?  

Change Alarm Limits?  

View or Change Datalog?  

Change Monitor Setup? 

Change Sensor Configuration? 
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Security Level 
There are three levels of security in the VRAE programming 
mode to provide further protection against unauthorized 
changes to the monitor alarm settings and other settings.  
The level 2 security allows a user to enter programming 
mode without any restriction.  This is the default security 
setting.  The level 1 security requires a 4-digit password to 
enter programming mode.  Level 0 security allows a user to 
enter the programming mode without any password 
checking, as in the level 2.  However, level 0 security does 
not allow a user to save any changes to the alarm limits, real 
time clock, correction factor, user and site information, etc.  
A user can still perform calibration with level 0 security.  
The security level must be set using a PC (see Section 5.0 
for details on setting up the security level). 
  
Once inside the programming mode, LCD will display the 
first menu.  Each subsequent menu item can be viewed by 
pressing the [N/-] repeatedly until the desired menu is 
displayed.  To enter the sub-menu of a particular menu, press 
the [Y/+] key and the sub-menu will be displayed.   
 
To exit the programming mode and return to the normal 
operation, press the [MODE] key at any of the first tier menu 
displays. 
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4.2 Keys for Programming Mode 
 
The three keys perform a different set of functions during 
the programming mode as summarized below. 
 

Table 4.2 
 Key  Function in Programming Menu 
 
[MODE]: Exit menu when press momentarily or 

exit data entry mode when pressed and 
held for 1 second 

 
[Y/+]:  Increase alphanumerical value for data 

entry or confirm (yes) for a question 
 
[N/-]: Decrease alphanumerical value for data 

entry or deny (no) for a question 
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4.3 Entering into Programming Menu  
 
1.  Turn on the VRAE monitor (refer to Section 2.3 for the 

power on sequence). 
 
2.  Press and hold down both [MODE] and [N/-] keys for 

three seconds to enter programming mode.  Note:  this 
is to prevent the user from entering the programming 
mode by accident.  

 
3. If the User mode is set to display mode, a message 

“Display Only!  Cannot enter....” will be shown.  
 
3. If the security level is 0 or 2, after holding down two 

keys for 3 seconds or more, the monitor will enter the 
programming mode and the first menu item.  “Calibrate 
Monitor?” will be displayed. 

4. If the security level is 1, or user mode is text mode, after 
holding down the two keys for three seconds, the display 
will show “Enter Password = 0000” with the left-most 
digit flashing.  The user should enter a password starting 
from this flashing digit. 

 
Note 1:  Prior to factory shipment, the VRAE monitor was 

installed with “0000” as the default password. 
  
Note 2:  For added security, “0000” is always displayed 

instead of the actual password at this step. 
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6. If the correct digit value is not “0”, use [Y/+] key or [N/-] 
key to increase or decrease the digit value.  Then press 
[MODE] key momentarily to confirm the digit value.  
Display shows the actual digit entered and moves the 
flashing cursor to the next digit (to the right). 

 
7. Repeat Step 5 until all four digits are entered.  Press and 

hold [MODE] key for one second. 
 
8. If the entered password is correct, the monitor enters the 

programming menu.  The first menu item “Calibrate 
Monitor?” will be displayed. 

 
9. If the password is incorrect, the display shows “Wrong 

Password” and returns to the regular display of 
instantaneous gas readings or sensor names (for text 
mode). 
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4.4 Calibration of VRAE Monitor 

CALIBRATION WARNINGS: 
 

The calibration of all newly purchased RAE Systems 
instruments should be tested by exposing the sensor(s) 
to known concentration calibration gas before the 
instrument is put into service the first time. 
 

For maximum safety, the accuracy of the VRAE should 
be checked by exposing the sensor(s) to known 
concentration calibration gas before each day’s use. 

 

In programming mode, the user may re-calibrate the sensors 
in the VRAE monitor.  This is a two-point calibration 
process using “fresh air“ and the standard reference gas (also 
known as Span Gas).  First, a “fresh air” which contains 
20.9% and no detectable, toxic or combustible gases is used 
to set the zero point for each sensor.  Then a standard 
reference gas, which contains a known concentration of a 
given gas, is used to set the second point of reference.  The 
two-point calibration procedure is detailed below.  Table 4.3 
shows the sub-menus for calibration operations. 
 

Table 4.3 
  Calibration Sub-Menu  
 Fresh Air Calibration? 

 VOL% Zero Calibration? 

 Multiple Sensor Calibration? 

 Single Sensor Calibration? 

 Modify Span Gas Value? 

 Change LEL/VOL Span Gas? 
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4.4.1 Fresh Air Calibration 

This procedure determines the zero point of the sensor 
calibration curve.  To perform fresh air calibration, the 
calibration adapter and a bottle of “fresh” air (optional) are 
recommended.  The “fresh” air is clean dry air with 20.9% 
oxygen concentration and without any organic, toxic or 
combustible gases or impurities.  If such an air bottle is not 
available, any clean ambient air without detectable 
contaminant can also be used.  A charcoal filter should be 
used if one is not sure of the ambient air’s purity. 

If the unit is in VOL or Autorange mode, a second zero is 
performed with the VOL zero gas, typically pure nitrogen.  
This zeroing step affects only the VOL sensor and does not 
modify the O2 calibration performed in the first zero step.  
In Autorange mode, the first step zeros the LEL sensor.  In 
VOL mode, the first step zeros the VOL sensor and the 
second step is needed only if the VOL zero gas is different. 

The calibration adapter links up the inlet port of the VRAE 
Monitor to the regulator of the gas bottle (see Figure 4.4.1). 

 Figure 4.4.1   Set-up of Gas Calibration 
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1. “Calibrate Monitor?” is the first menu item in Table 4.1.  
Press [Y/+] to perform calibration.  The first sub-menu 
shows: “Fresh Air Calibration?” 

 
2. If the “fresh” air bottle is available, snap in the 

calibration adapter over the inlet port of the VRAE 
Monitor and connect the other end of the tube to the 
fresh gas bottle, as shown in Fig. 4.4.1.  If the “fresh” air 
bottle is not available, simply leave the monitor in an 
area free of any detectable vapor.  

 
3. Press the [Y/+] key to start “fresh air calibration” of the 

monitor.  The display shows “zero... in progress” 
followed by the name of each sensor and the message 
“zeroed.”  The display should show a reading “0.0”, or a 
very small number, for all sensors.  For the oxygen 
sensor in model PGM-7800, it should show a “20.9” as 
the reading. 

 
1. After about 30 seconds pause, the display will show the 

message “Zero Cal Done!  Reading=” and the 
instantaneous fresh air readings. 

 
2. Press either [Y/+] or [MODE] once and move to the next 

sub-menu “Vol% Zero Calibration?”.  Apply the Vol% 
Zero gas and press [Y/+] to start. The display shows 
“zero... in progress…” followed by “Zero cal 
done…Reading = 0”.  

 
3. Press either [Y/+] or [MODE] once and move to the next 

sub-menu “Multiple Sensor Calibration?”  
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4.4.2 Multiple Sensor Calibration 

This function simultaneously determines the second point of 
calibration curves for multiple sensors in the monitor. 
A bottle of mixed standard reference gases is needed to 
perform this procedure.  The user can choose several gas 
mixtures* to be used in multiple-sensor calibration.   

For use in Autorange mode, the unit should first be 
calibrated in LEL (or Autorange) mode to span the LEL 
sensor, then switched to VOL% mode to span the VOL 
sensor, and finally returned to Autorange.  In VOL mode, the 
calibration and measurement gas must be the same. 

Snap in the calibration adapter over the gas inlet port of the 
VRAE Monitor, and connect the tube to the mixed gas bottle 
as shown in Figure 4.4.1.  
 

1. Continuing from Step 4 of the previous section, the 
display should show “Multiple Sensor Calibration?”  
Press the [Y/+] key.  The display shows all the pre-
selected gases for the mixed gas bottle and “OK?” 
question (as shown below for PGM-7800).  Press [Y/+] 
key to accept the multiple sensor selection and start the 
calibration, or press the [N/-] key to modify the sensor 
selection and go to Step 6.  
 

CO     - - - -  H2S 

LEL      OK? OXY 
 

2.  Turn on the valve of the mixed gas bottle to start the flow 
of the span gas.  Display shows “Apply Mixed Gas” and 
will wait for the calibration gas to reach the sensor.  
When the calibration gas has reached the sensor the 
display will show “calibration in progress… 60” with the 
countdown timer shows the number of remaining 
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seconds while the monitor performs calibration.  When 
the countdown timer reaches 0, the display shows the 
name of each sensor, the message “cal’ed!” and the 
calibrated value for each gas.  If no gas has reached the 
sensor after 60 seconds, the display will show “ No gas 
flow…” and abort the calibration. 

 

Note 1:  The readings should be very close to the span 
gas values.  After about 30 seconds pause, the display 
will show the message “Span Cal Done!  Turn Off Gas” 

 

Note 2:  Some sensors, such as ammonia and chlorine 
dioxide, require longer equilibration times than 60 
seconds. These sensors should be calibrated separately in 
a Single Sensor Calibration (Section 4.4.3). 

 

3. This completes the multiple sensor calibration procedure 
and moves to the next sub-menu item.  

 

4. Turn off the flow of gas.  Disconnect the calibration 
adapter from the VRAE Monitor.  

 

5. Press the [MODE] key any time during Step 2 to abort 
the calibration.  If a sensor failed the calibration, the 
sensor name and an error message “failed, continue?” 
will appear.  Press the [N/-] or [MODE] key to abort the 
calibration.  Press the [Y/+] key to continue the next 
sensor calibration.  In either case, the calibration data for 
the current sensor is not changed. 

 

From Step 1, if [N/-] is pressed, the display shows all the 
sensor names selected for multiple sensor calibration with 
the cursor blinking at the first sensor.  
 
 

CO*     - - - -  H2S* 

LEL*       OK? O2 
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Press the [Y/+] key to select the sensor and the [N/-] key 
to de-select the sensor.  A previously selected sensor 
will show an “*” next to the sensor name.  A previously 
de-selected sensor will not show an “*” next to the 
sensor name.  

 

6. Press the [MODE] key momentarily to move from one 
sensor location to the next one.  Repeat Step 7 until all 
of the sensors that need to be calibrated during multiple 
sensor calibration are selected.  Press and hold the 
[MODE] key for 1 second to save the new sensor 
selection.   

 

7. The display shows “Save?”  To confirm the new 
selection, press the [Y/+] key to accept the change and 
continue on with Step 2.  Press the [N/-] key or the 
[MODE] key to discard the change and to continue on 
with Step 2. 

 

*Cross Sensitivity: Some sensors may show cross 
sensitivity to other gases.  Therefore, it is important to 
choose the gas mixture carefully for the multiple sensor 
calibration to avoid erroneous calibration due to cross 
sensitivity.  For example, some toxic gases are known to 
cause erroneous readings by the CO sensor.  In general, it is 
recommended to calibrate the CO, H2S sensors, combustible 
and oxygen sensor with a bottle of mixed gas using the 
multiple sensor calibration procedure and to calibrate the 
other toxic sensor with a bottle of a single toxic gas. 
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4.4.3 Single Sensor Calibration 

This procedure determines the second point of the sensor 
calibration curve for a single sensor.  A bottle of standard 
reference gas (span gas) is needed to perform this 
procedure.  Table 2.2 shows the standard calibration gases 
typically used as span gases in the factory.  Snap in the 
calibration adapter over the inlet port of the VRAE monitor, 
and connect the tube to the regulator of the gas bottle as 
shown in Figure 4.4.1  
 
1.  Continuing from Step 4 or Step 6 of the previous section, 

the display should show “Single Sensor Calibration?”  
Press [Y/+] key.  The display shows all the installed 
sensors in the monitor with the cursor blinking at the 
first sensor location.  Press [Y/+] key to select the high-
lighted sensor and start the calibration, or press 
[MODE] key momentarily to move to the next sensor 
location.  

CO     SO2  H2S 

LEL    pick? OXY 

2.  Turn on the valve of the CO gas bottle to start the flow of 
the span gas.  Display shows “Apply CO Gas” and the 
span value set.  The VRAE monitor will wait for the 
calibration gas to reach the sensor.  When the calibration 
gas has reached the sensor the display will show 
“calibration in progress… 60” with the countdown timer 
shows the number of remaining seconds while the 
monitor performs calibration.  When the countdown 
timer reaches 0, the display shows the sensor name and 
the calibrated value: 
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CO cal’ed 

reading =  50  ppm 

  
If no gas has reached the sensor after 60 seconds, the 
display will show “No gas flow…” and abort the 
calibration. 
 
Note:  The reading should be very close to the span gas 
value.  After about 30 seconds pause, the display will 
show the message “Span Cal Done!  Turn Off Gas” 

 
3.  This completes the single gas calibration procedure for 

one sensor.  The display shows the single gas calibration 
sub-menu for the user to select another sensor or move 
to next calibration sub-menu. 

 
4. Turn off the flow of gas.  Disconnect the calibration 

adapter from the VRAE Monitor. 
 
5. Repeat Step 1 to Step 5 to calibrate the next sensor. 
 
6. Press the [MODE] key any time during Step 2 abort the 

calibration.  If the sensor failed the calibration, the 
sensor name and an error message “failed, continue?” 
will appear.  Press [N/-] or [MODE] key to abort the 
calibration.  Press [Y/+] to repeat the single gas 
calibration.  In either case, the current calibration data 
will not be changed. 

 

 

 



PROGRAMMING OF VRAE 

4 - 15 

Oxygen Sensor Calibration (Not applicable to PGM-7840) 

The oxygen sensor calibration is slightly different from all 
other sensors.  The oxygen sensor measures a range from 0 
to 30% of oxygen in the air.  During “fresh” air calibration, 
the oxygen sensor is calibrated to fixed 20.9% of oxygen.  
During single sensor calibration, the user can supply a bottle 
of pure nitrogen gas so that the oxygen sensor can be 
calibrated to 0% of oxygen.  The user can also supply other 
span concentrations of the oxygen, e.g. 19.5%, to calibrate 
the oxygen sensor.  A question “0% oxygen?” will be asked.  
Enter [Y/+] if pure nitrogen gas is used to calibrate the 
oxygen sensor.  Otherwise, enter [N/-] to calibrate the 
oxygen sensor to another span oxygen value.  During both 
single or multiple sensor calibration, the oxygen sensor will 
be calibrated to the span value defined in Section 4.4.4. 

Note:  After a “0% oxygen” calibration, the user must 
perform a fresh air calibration to ensure that the 
oxygen sensor is calibrated correctly. 

 

Calibration Time Stamp 

When a single or multiple sensor calibration is performed, a 
time stamp will be stored in the non-volatile memory.  This 
information will be included in the datalogging report. 
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4.4.4 Modify Span Gas Value 

This function allows the user to change the span values of 
the standard calibration gases.  The lower left position may 
toggle between different values when switching between 
LEL(or Autorange) or VOL% modes. 
 
1. “Modify Span Gas Value?” is the next sub-menu item in 

Table 4.3.  

2. Press [Y/+] key.  Display shows: 

50     10.0     25 

50     span 20.9 

A cursor is blinking at the first digit of the first Span 
value.  If the user wants to modify any one of the span gas 
values, go to Step 3.  Otherwise, press and hold the 
[MODE] key for 1 second to accept the previously stored 
span gas value and move to the next calibration sub-
menu. 

3. Starting from the left-most digit of the span gas value, 
use [Y/+] or [N/-] key to change the digit value and press 
[MODE] key momentarily to advance to next digit, the 
cursor will move to the next digit to the right.  Repeat 
this process until all span gas values are entered.  Press 
and hold the [MODE] for 1 second to save the new 
calibration gas value.   

4. The display shows “Save?”  To confirm the new value, 
press the [Y/+] key to accept the change.  Press the [N/-] 
key or the [MODE] key to discard the change and move 
to the next calibration sub-menu.  
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4.4.5 Change LEL/VOL Span Gas 

This function allows the user to select a specific LEL and/or 
VOL gas to be used as the span gas during LEL/VOL gas 
calibration.  The LEL and VOL gases must be the same.  For 
the LEL mode, setting this gas lets the unit apply the proper 
correction factor when calibrating to methane.  For 
Autorange mode, it also sets the cross-over concentration 
where the unit switches from 100% LEL to the 
corresponding volume % reading. Finally, it selects the 
proper firmware linearization algorithm for different gases. 
 
1. “Change LEL Span Gas?” is the next sub-menu item in 

Table 4.3.  

2. Press [Y/+] key.  If a LEL sensor is installed or a 
combination LEL/VOL sensor is installed and the sensor 
is set to LEL mode, the display shows: 

LEL Span=? 

Methane 

If in VOL mode, the display shows “Vol span = ? 
Methane”.  If no LEL/VOL sensor is installed, the 
message “No LEL installed“ will appear.  

3. If the user does not want to change the LEL or VOL span 
gas, press [Y/+] key to accept the current selection and 
exit this sub-menu. 

4. If the user wants to select a different LEL or VOL span 
gas, press [N/-].  Then use [Y/+] or [N/-] to scroll 
through a list of gas names until a desired gas name 
appears in the display; then press [MODE] to select the 
new gas name. 
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5. The display shows “Save?”  To confirm the new gas 
selection, press the [Y/+] key to accept the change.  Press 
the [N/-] key or the [MODE] key to discard the change 
and return to the first display. 
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4.5   Change Alarm Limits   
 
In the programming mode, the users may change alarm limits 
of each sensor for the VRAE Monitor.  Table 4.4 shows the 
sub-menus for changing the alarm limits. 
 
   Table 4.4 

 Alarm Limit Sub-Menu  
 Change High Alarm limit? 
 

 Change Low Alarm limit? 
 

 Change STEL alarm limit?  

 Change Average alarm limit?  

 
1. The sub-menu item in Table 4.4 allows the user to change 

the high alarm limit, low alarm limit, STEL alarm limit or 
average alarm limit. The lower left position may toggle 
between different values when switching between LEL 
(or Autorange) or VOL% modes. The average alarm limit 
can be “Running Average” or “TWA (Time Weight 
Average) depending on the menu selection on “Change 
Averaging Method” (see Section 4.7.8).  Press [N/-] to 
circle through the sub-menu.  Press [Y/+] to enter a sub-
menu and the display shows “HIGH,” “LOW,” “STEL,” 
“TWA” or “AVG” with a flashing cursor on the left-most 
digit of the previously stored alarm limits. 

 

200      100.0     20 

20      HIGH  23.5 
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35       50.0      10 

10     LOW  19.5 
 

100       25.0      15 

     STEL   
 

35       10.0      10 

      TWA  
 

1.0      10.0      10 

      AVG  

  
2. To modify this limit, starting from the left-most digit, 

use the [Y/+] or [N/-] key to change the digit value and 
press the [MODE] key momentarily to advance to the 
next digit.  The flashing digit will move on to the next 
digit to its right.  Repeat this process until all the new 
Alarm limits are entered.  Press and hold the [MODE] 
key for 1 second to exit data entry mode.  If there is any 
change to the existing value, the display shows “Save?”  
Press the [Y/+] key to accept the new value and move to 
the next sub-menu.  Press the [N/-] key to discard the 
changes. 

   
To preserve the previously stored alarm limit, press and hold 
the [MODE] key for 1 second and the monitor will exit data 
entry mode and move to the next sub-menu.  
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4.6 View or Change Datalog 
 
VRAE monitor calculates and stores the gas readings at a 
specified interval.  The user can review these stored readings 
or change datalog setup from the programming mode.  Users 
can also program additional datalog options in a PC and 
download them to the monitor (see Section 5.0 for details 
on how to program additional datalogging options).  Table 
4.5 shows the sub-menus for datalog options: 
 

Table 4.5 
 Datalog Sub-Menu  
 Reset Peak and Minimum? 

 Clear All Data?* 

 Change Datalog Period?* 

 Select Data Type?* 

 View Datalog?* 

 Enable / Disable Datalog?* 
 

* Not applicable to non-datalog monitor 
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4.6.1 Reset Peak and Minimum 

 
This function will reset peak and minimum data stored in the 
data memory. 
 
1. “Reset Peak and Minimum?” is the first sub-menu item 

in Table 4.5.   
 
2. Press the [Y/+] key to clear the peak and minimum data 

memory.  Display shows “Are You Sure?” to re-confirm 
whether to reset peak and minimum data. 

 
3. Press the [Y/+] key again will reset peak and minimum 

data. 
 
4. Press the [N/-] or [MODE] key to exit without resetting 

the data and move to next datalog sub-menu. 
 
Note:  STEL and TWA (or AVG) value will not be affected 
when peak and minimum values are reset. 
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4.6.2 Clear All Data 

 
This function will erase all data stored in the non-volatile 
data memory.  This does not change STEL, TWA, Peak, 
minimum concentration and run time values which are stored 
in the regular data memory. 
 
1. “Clear All Data?” is the second sub-menu item in Table 

4.5.   
 
2. Press the [Y/+] key to clear the data memory.  Display 

shows “Are You Sure?” to re-confirm the clearing of 
memory. 

 
3. Press the [Y/+] key again will erase all the data memory. 
 
4. Press the [N/-] or [MODE] key to exit without clearing 

the data memory and move to next datalog sub-menu. 
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4.6.3 Change Datalog Period 

 
The datalog period can be programmed from 1 to 3,600 
seconds (1 hour). 
 
1. “Change Datalog Period?” is the third sub-menu item in 

Table 4.5.   
 
2. Press the [Y/+] key, the display shows “New Period = 

0060” with the left-most digit flashing, where “0060” is 
the previously stored data log period. 

 
3. To modify this period, starting from the left-most digit, 

use the [Y/+] or [N/-] key to change the digit value and 
press the [MODE] key momentarily to advance to the 
next digit.  The flashing digit will move to the next digit 
to the right.  Repeat this process until all 4 digits of the 
new period are entered. Press and hold the [MODE] key 
for 1 second to exit data entry mode.   

 
4. If there is any change to the existing value, the display 

will show “Save?”  Press the [Y/+] key to accept the new 
value.  Press the [N/-] key to discard the changes and 
move to the next menu option. 

 
5. To preserve the previously stored period, press and hold 

the [MODE] key for 1 second.  The monitor will exit data 
entry mode and move to the next sub-menu item in Table 
4.5. 
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4.6.4 Select Data Type 

 
The user can choose to store either the average or the peak 
value during each datalog period.   
 
1. “Select Data Type?” is the fourth sub-menu item in Table 

4.5.   
 
2. Press the [Y/+] key, the display shows the current data 

type, for example, “Data Type = Average?”   
 
3. Press the [Y/+] key to accept the currently displayed data 

type.  Press [N/-] key to change to the other data. type:  
“Data Type = Peak?”  Press [MODE] key to exit this 
sub-menu and move on to the next sub-menu. 

 
4.  If there is any change to the existing selection, pressing 

the [y/+] key, the display will show “Save?”  Then, press 
the [Y/+] key to accept or the [N/-] key to discard and 
move to the next sub-menu. 

 

Note:  It is necessary to select “Average” data type in order 
to calculate the correct STEL and TWA data for 
datalogging report (see Section 5.9). 
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4.6.5 View Datalog 
 

This function allows the user to review all the data that is 
stored in the non-volatile data memory.  
 

1. “View Datalog?” is the fifth sub-menu item in Table 4.5.  
Press the [Y/+] key and the LCD display shows the first 
event number and start date and time of the event. 

 

Event #  1  ? 

   8/3/96  8:20 
 

2. Press [Y/+] key to review data of the first event.  The 
LCD display shows the data number and time stamp for 2 
seconds followed by the stored data of each sensor: 

 

Data # 0        

    8:20:00  
 

1       0.0       0 

 2      +/-   20.5 
 

3. Press the [Y/+] or [N/-] key to move forward or backward 
to view other data of this event.  When reaching the 
beginning or the end of the event, the message “Start of 
data!” or “End of data!” will appear.  Press [MODE] key 
to exit the current event. 

 

4. Press [N/-] key at Step 2 to see next event.  If there is no 
more event, the message “No More Events!  Start from 
#1?” will appear.  Press [N/-] key to go back to the 
current event or [Y/+] key to go to the first event.  Press 
[MODE] to exit and move to the next sub-menu. 
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4.6.6 Enable / Disable Datalog 

 
The user can choose to enable or disable the datalogging 
function on each individual sensor.  This allows users to 
selectively log certain sensor readings of interest. 
 
1. “Enable / Disable Datalog?” is the sixth sub-menu item in 

Table 4.5.  
 
2. Press [Y/+] key.  The display shows all the installed 

sensors in the monitor.  A previously selected sensor to 
be datalogged is marked with an “*” next to the sensor 
name.  The cursor is blinking at the first sensor location.  
Press [Y/+] key to enable the datalogging for the sensor 
and [N/-] key to disable the datalogging.   

CO*     SO2  H2S* 

LEL     pick OXY 
 

3. Press [MODE] key momentarily to move from one 
sensor location to the next one.  Repeat Step 2 until all 
the sensors that needed to be datalogged are selected.  
Press and hold [MODE] key for 1 second to save the 
new sensor selection.   

 
4. The display shows “Save?”  To confirm the new 

selection, press the [Y/+] key to accept the change.  Press 
the [N/-] key or the [MODE] key to discard the change 
and return to the first datalog sub-menu.    
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4.7 Change Monitor Setup   
 
In the programming mode, the users may change monitor 
setup or enter user information for the VRAE monitor.  
Table 4.6 shows the sub-menus for changing the monitor. 
 

Table 4.6 
 Monitor Setup Sub-Menu     
 Change Site ID? 
 

 Change User ID? 
 

 Change Alarm Mode? 
 

 Change User Mode? 
 

 Change Real Time Clock?  

 

 Change Backlight Mode? 
 

 Change Password? 
 

 Change Pump Speed? 
 

 Change Averaging Method? 
 

 Set Temperature Unit? 
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4.7.1 Change Site ID & Change User ID 

 
The user can enter an 8 digit alphanumeric site ID & User ID 
in the programming mode.  These ID’s will be included in 
the datalog report.  

1. “Change Site ID?” and “Change User ID?” are the first 
and second sub-menu items in Table 4.6.   

 
2. Press [MODE] key to choose one of them and press the 

[Y/+] key, the display shows the current site ID: “Site ID 
= xxxxxxxx” or the current user ID: “User ID = 
xxxxxxxx” with the left most digit flashing. 

 
3. Press the [Y/+] or [N/-] key to cycle through all 26 

letters and 10 numerals.  Press [MODE] key 
momentarily to advance to the next digit.  The flashing 
digit will move to the next digit to the right.  Repeat this 
process until all 8 digits of the new site ID are entered.   

 
4. Press and hold the [MODE] key for 1 second to exit the 

data entry mode and move to the next monitor setup sub-
menu. 

 
5. If there is any change to the existing site ID, the display 

shows “Save?”  Press the [Y/+] key to accept the new site 
ID and exit the monitor setup sub-menu.  Press the [N/-] 
key to discard the changes and move to the next sub-
menu. 
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4.7.2 Change Alarm Mode 

 
There are two different alarm modes: Latched and 
Automatic Reset in VRAE that can be selected from the 
programming menu. 

1. “Change Alarm Mode?” is the third sub-menu item in 
Table 4.6. 

 
2. Press the [Y/+] key, the display shows the current alarm 

mode selection:  “Alarm Mode = Latched?” 
 
3. Press the [Y/+] key to accept the currently displayed 

alarm mode.  Press [N/-] key to change to the other alarm 
mode:  “Alarm Mode = Auto reset?”  Press [MODE] key 
to exit this sub-menu and move to the next monitor setup 
sub-menu. 

 
4. If there is any change to the existing selection, pressing 

the [Y/+] key the display will show “Save?”  Then, press 
the [Y/+] key to accept or the [N/-] key to discard the 
change and move to the next sub-menu. 
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4.7.3 Change User Mode 

 
There are three different user modes:  text, display, and 
program in VRAE that can be selected from the 
programming menu.  

1. “Change User Mode?” is the fourth sub-menu item in 
Table 4.6. 

 
2. Press the [Y/+] key, the display shows the current user 

mode selection:  “User Mode = Program?” 
 
3. Press the [Y/+] key to accept the currently displayed user 

mode.  Press [N/-] key to scroll through the other two 
user modes.  Press [MODE] key to exit this sub-menu 
and move to the next monitor setup sub-menu. 

 
4. If there is any change to the existing selection, pressing 

the [Y/+] key the display will show “Disable Program!  
Are you Sure?”  Then, press the [Y/+] key to accept or the 
[N/-] key to discard and move to the next sub-menu. 

 
Caution:  If the user mode is changed to display mode, the 
user can no longer enter the programming menu.  Therefore, 
the user cannot change the user mode back to program 
mode from the monitor.  The only way to change the user 
mode back to “program” mode is to use a PC and the 
ProRAE-Suite program or Turn on unit in diagnostic 
mode and then enter the program mode by entering 
correct password (see Section 5 for details). 
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4.7.4 Change Real Time Clock 

 
The VRAE monitor is equipped with a real time clock.  The 
user can enter the correct date and time into the real time 
clock in the programming mode. 

1. The fifth sub-menu item in Table 4.6 is “Change Real 
Time Clock?”     

 
2. Press [Y/+] key, the display shows both the current date 

and time:  Date:  “mm/dd/yy” and Time:  “hh:mm” with 
the left most digit of the date flashing.    

 
3. To modify this value, use the [Y/+] or [N/-] key to change 

the digit value and press the [MODE] key momentarily to 
advance to the next digit.  The flashing digit will move on 
to next digit to its right.  Repeat this process until the 
new date and time values are entered.  Press and hold the 
[MODE] key for 1 second to exit data entry mode.   

 
4. If there is any change to the existing value, the display 

shows “Save?”  Press the [Y/+] key to accept the new 
value and move to next sub-menu.  Press the [N/-] key to 
discard the changes and move to next sub-menu.  
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4.7.5 Change Back Light Mode 

 
The VRAE monitor allows the user to choose to turn on and 
off LCD back light automatically when ambient light falls 
below or above a threshold level or to turn on and off the 
back light manually by pressing the [N/-] key. 

 

1. The sixth sub-menu item in Table 4.6 is “Change 
Backlight Mode?”     

 
2. Press [Y/+] key, the display shows the current back light 

mode:  “Back Light Mode = Auto turn on?” 
 
3. Press the [Y/+] key to accept the currently displayed back 

light mode.  Press [N/-] key to change to the other back 
light mode:  “Back Light Mode = manual turn on?”  Press 
[MODE] key to exit this sub-menu and move to the next 
monitor setup sub-menu. 

 
4.  If there is any change to the existing selection, pressing 

the [Y/+] key the display will show “Save?”  Then, press 
the [Y/+] key to accept or the [N/-] key to discard and 
move to the next sub-menu. 
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4.7.6 Change Password 

 
The user can modify the password from the monitor. 

1. The seventh sub-menu item in Table 4.6 is “Change 
Password?”  

2. Press the [Y/+] key and the display shows the current 
password:  “Enter new password = xxxx” with the left 
most digit flashing. 

3. Press the [Y/+] or [N/-] key to cycle through all 10 
numerals.  Press [MODE] momentarily to advance to the 
next digit.  The flashing digit will move to the next digit 
to the right.  Repeat this process until all 4 digits of the 
new password are entered.   

4. Press and hold the [MODE] key for 1 second to exit the 
data entry mode and move to the next monitor setup sub-
menu. 

5. If there is any change to the existing password, the 
display shows “Save?”  Press the [Y/+] key to accept the 
new password.  Press the [N/-] key to discard the changes 
and move to the next sub-menu. 

6. The monitor next asks for this value to be confirmed. 
“Confirm New Password = 0000” with the left most digit 
flashing.  The number must be re-entered as before to 
exit the monitor setup sub-menu.  If a different entry is 
entered in the second time, the password reverts to its 
original setting. 



PROGRAMMING OF VRAE 

4 - 35 

4.7.7 Change Pump Speed 

 
There are two speed settings for the pump motor in the 
VRAE that can be selected from the programming menu: 
low (default) and high.  The “high” setting should be used 
for long lengths of tubing or when rapid changes in input 
conditions are expected.  “Low” may be selected when the 
operating conditions are slow to change and a quick 
response is not required.  Low may also be used to prolong 
pump motor life, LEL sensor life and battery run time.  Note 
that this screen may not be present for diffusion models or 
if speed control is not available. 

1. “Change Pump Motor Speed?” is the eighth sub-menu 
item in Table 4.6. 

 
2. Press the [Y/+] key, the display shows the current pump 

speed selection:  “Pump Speed = Low?” 
 
3. Press the [Y/+] key to accept the currently displayed 

pump speed and move to the next monitor setup sub-
menu.  Press [N/-] key to change to the other speed  
“Pump Speed = High?”  Press [MODE] key to exit this 
sub-menu and move to the next monitor setup sub-menu. 
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4.7.8 Change Averaging Method 

 
There are two methods of calculation used in the averaging 
of the monitor.  Using this selection can cause the 
calculation to be performed using an eight-hour time 
weighted average (TWA), the default, or a running average 
(AVG).  The display indicator for whichever averaging type 
is selected will show on the LCD display wherever the 
average is indicated. 

1. “Change Averaging Method?” is the ninth sub-menu item 
in Table 4.6. 

 
2. Press the [Y/+] key, the display shows the current 

average selection:  “Average Type = TWA?” 
 
3. Press the [Y/+] key to accept the currently displayed 

type.  Press [N/-] to change to the other selection: 
“Average Type = Running Average?” and [Y/+] to accept 
the selection. 

 
4. If there is any change to the existing selection, pressing 

the [Y/+] key, the display will show “Save?”  Then, press 
the [Y/+] key to accept or the [N/-] key to discard and 
move to the next sub-menu. 
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4.7.9 Set Temperature Unit 

 
The monitor can be set up to give either Fahrenheit or 
Celsius units wherever the temperature is displayed.  

4. “Set Temperature Unit?” is the tenth sub-menu item in 
Table 4.6. 

 
5. Press the [Y/+] key, the display shows the current 

temperature unit selection:  “Temp Unit = Fahrenheit?” 
 
6. Press the [Y/+] key to accept the currently displayed 

type or press [N/-] to change to the other selection: 
“Temp Unit = Celsius?” and [Y/+] to accept the 
selection. 

 
7. If there is any change to the existing selection, pressing 

the [Y/+] key, the display will show “Save?”  Then, press 
the [Y/+] key to accept or the [N/-] key to discard and 
move to the first setup sub-menu. 
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4.8 Change Sensor Configuration 
 
In the programming mode, the users may change several 
sensor related configurations of the VRAE monitor.  Table 
4.7 shows the sub-menus for setting various configurations 
of the sensors. 
 
   Table 4.7 

Sensor Configuration Sub-Menu     
 Change LEL/VOL Sensor Type? * 
 

 Enable / Disable Sensors? 
 

 Change Dilution Ratio?  

 

 Change LEL/VOL Gas Selection?* 

 
* Note:  This menu is applicable only if a combination 
LEL/VOL sensor is installed. 
 
Before these sub-menus are described, the term “Correction 
Factor” (CF) needs to be explained: 
 
Correction Factor 
The LEL sensor used in VRAE is a broad band sensor (i.e., it 
responds to a broad range of gases).  Typically, these 
sensors show a different sensitivity to different gases.  The 
correction factor for a specific gas is defined as: 
 
     sensitivity to a calibration gas 
Correction Factor   =   ________________________ 

     sensitivity to a specific gas 
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Correction factors are often used to obtain a calculated 
concentration of a specific gas while using a different gas 
during calibration.  When the unit is calibrated to %LEL 
methane, the CF is multiplied by the reading to obtain the 
true %LEL concentration of the measured gas.  The factor 
incorporates the difference in LEL levels of the two gases. 
 
The VRAE monitor stores one set of correction factors for 
the LEL sensor.  This set consists of about 40 different 
gases.  The user can choose one gas from the list to be the 
calibration gas and another gas to be the measurement gas.  
For example, the user can choose methane as the calibration 
gas for the LEL sensor and select pentane as the 
measurement gas.  The VRAE monitor will calculate the 
correction factor between these two gases and convert the 
measured value of the LEL sensor into equivalent 
concentration of the pentane gas. 
 

Note 1:  Using the correction factor can provide a rough 
estimate the target measurement gas.  In order to achieve the 
specified accuracy of the instrument, it is necessary to 
calibrate the LEL sensor with the specific target gas. 

Note 2:  No correction factors are built in for the VOL 
sensor, but selecting the measurement gas type in this mode 
ensures switching between LEL and VOL at the correct 
volume % concentration equivalent to 100% LEL. For VOL 
measurements the calibration and measurement gas must be 
the same, and the factor is always 1.0. 

 



PROGRAMMING OF VRAE 

4 - 40 

4.8.1 Change LEL/VOL Sensor Type 

 
This programming menu only applies to the monitors with a 
combination LEL/VOL sensor installed.  This sensor can be 
setup as a %LEL sensor to measure the combustible gas in 
the %LEL level. It can also be set up to measure 
combustible gases in the % volume level up to 100%. The 
user can also set up the sensor so that it will automatically 
switch from %LEL to %VOL when the %LEL sensor 
reaches 100% LEL. However, this auto-ranging feature only 
works for gases listed in the built-in library.  The user can 
select one of these sensor modes from the programming 
menu.  

1. “Change LEL/VOL Sensor Type?” is the first sub-menu 
item in Table 4.7. 

 
2. Press the [Y/+] key, the display shows the question: 

“Switch to %LEL?” 
 
3. Press the [Y/+] key to accept the currently displayed 

sensor mode.  Press [N/-] key to change to the other 
mode.  Press [MODE] key to exit this sub-menu and 
return to the first sub-menu. 

 
4. If there is any change to the existing selection, pressing 

the [Y/+] key the display will show “Save?”  Then, press 
the [Y/+] key to accept the [N/-] key to discard and 
advance to the next sub-menu. 
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4.8.2  Enable / Disable Sensor 

 
This function allows the user to selectively enable or disable 
individual sensors in the VRAE monitor.  When a sensor is 
disabled, the sensor will not measure nor display the gas 
concentration. 
 
1. “Enable / Disable Sensors?” is the second sub-menu item 

in Table 4.7.  
 
2. Press [Y/+] key.  The display shows all the installed 

sensors in the monitor.  A previously enabled sensor is 
marked by an “*” next to the sensor name.  The cursor 
will blink at the first sensor location.  Press [Y/+] key to 
enable the sensor and [N/-] key to disable the sensor.  A 
previously disabled sensor will show “----” instead of the 
sensor name. 

CO*     SO2  H2S* 

LEL*     pick       OXY* 

3. Press [MODE] key momentarily to move from one 
sensor location to the next one.  Repeat Step 2 until all 
the sensors that needed to be enabled are selected.  Press 
and hold [MODE] key for 1 second to save the new 
sensor selection. 

 
4. The display shows “Save?”  To confirm the new selection, 

press the [Y/+] key to accept the change.  Press the [N/-] 
key or the [MODE] key to discard the change and move 
to the next sub-menu. 
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4.8.3 Change Dilution Ratio 

 
The user can insert an optional dilution fitting on the VRAE 
gas inlet port to dilute the gas sample.  The user can enter a 
dilution ratio (from 1 to 10) from the programming menu so 
that the reading can be compensated to show the actual 
concentration of the gas sample with the dilution fitting. 

1. “Change Dilution Ratio?” is the third sub-menu item in 
Table 4.7. 

 
2. Press the [Y/+] key, the display shows:  “New Ratio = xx 

(1- 10)” with the left most digit flashing. 
 
3. Press the [Y/+] or [N/-] key to increase or decrease the 

value of the digit.  Press [MODE] key momentarily to 
advance to the next digit.  The flashing digit will move to 
the next digit to the right.  Repeat this process until both 
digits of the new dilution ratio are entered. 

 
4. Press and hold the [MODE] key for 1 second to exit the 

data entry mode and move to the next sub-menu. 
 
5. If there is any change to the existing dilution ratio, the 

display shows “Save?”  Press the [Y/+] key to accept the 
new ratio and exit the sub-menu.  Press the [N/-] key to 
discard the changes and move to the next sub-menu. 
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4.8.4 Change LEL/VOL Gas Selection 
 

This function allows the users to choose one of the pre-
stored LEL gases in the monitor and calculate its correction 
factor relative to the LEL calibration gas.  This factor will 
then be used during gas measurements to show the 
equivalent concentration of the selected LEL gas.  The user 
can also modify this relative correction factor to increase or 
decrease the gas reading.  This allows the users to create a 
custom factor for a specific gas or mixture of gases. 
 

Note:  No correction factors are built in for the VOL sensor, 
but selecting the measurement gas type in this mode ensures 
switching between LEL and VOL at the correct volume % 
concentration equivalent to 100% LEL. For VOL 
measurements the calibration and measurement gas must be 
the same, and the factor is always 1.0. 
 
1. “Change LEL Gas Selection?” is the fourth sub-menu 

item in Table 4.7 
2. Press [Y/+] key.  If an LEL sensor is installed and 

enabled, or a combination LEL/VOL sensor is installed 
and the sensor is set to LEL mode, the display shows: 

LEL Gas = ? 

methane 

If the unit is in VOL mode, the display shows “VOL gas = 
?… Methane…”. If no LEL/VOL sensor is installed, the 
message “No LEL installed” will be displayed and the 
unit returns to the first sub-menu. 

3. If there is no change in the LEL/VOL measurement gas, 
press [Y/+] to accept the current gas and skip to Step 6. 
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4. If the user wants to modify the LEL/VOL measurement 
gas, press [N/-] key first, then use [Y/+] or [N/-] key to 
scroll through a list of gas names until the desired gas 
name appears in the LCD display, then press [MODE] 
key to select the new gas name. 

5. The display shows “Save new gas?”  To confirm the new 
gas, press the [Y/+] key to accept the change.  Press the 
[N/-] key or the [MODE] key to discard the change and 
move to the next step.6. The display shows 

 

Methane 

LELFactor=1.00? 

 where “1.00” is the calculated correction factor of the 
selected gas in Step 4.  See Appendix B or Technical 
Note 156 for the proper correction factor.  Note that the 
factors are not the same in the LEL-only and LEL/TC 
sensors. 

7. If the user does not want to modify the LEL correction 
factor, press [Y/+] and go to Step 8.  To modify this 
factor, press [N/-] first. Then, starting from the left-most 
digit, use the [Y/+] or [N/-] key to change the digit value 
and press [MODE] momentarily to advance to the next 
digit.  The flashing digit will move on to next digit to its 
right.  Repeat this process until all 4 digits of the new 
factor are entered.  Press and hold [MODE] for 1 second 
to exit data entry mode.  If there is any change to the 
existing value, the display shows “Save?”  Press [Y/+] to 
accept the new value and exit the gas selection sub-menu.  
Press [N/-] to discard the changes. 
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4.9 Exit Programming Mode 

 
1. To exit programming mode from the first tier menu level 

(see Table 4.1), press the [MODE] key once.  
 Display shows an instantaneous reading of normal 

operation mode. 
 
2. To exit programming mode from 2nd tier sub-menu level 

(see Table 4.2 - 4.6), press the [MODE] key twice. 
 
3. To return to programming mode, press and hold down 

both the [MODE] and [N/-] keys for 3 seconds as 
described in Section 4.4. 
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5 COMPUTER INTERFACE 
 
Each VRAE with datalogging option is shipped with a 
software package, called ProRAE-Suite, and a serial 
computer interface cable.  
 
This software package runs on any IBM compatible Personal 
Computer (PC) under Windows 95, Windows 98, 
Windows NT 4.0, Windows ME, Windows 2000, and 
later environments.  It allows the user to configure the 
VRAE monitor through a user-friendly interface and send 
the configuration information from the PC to the VRAE 
monitor.  Collected data can also be extracted from the 
VRAE monitor to the PC in order to perform data analysis, 
report generation or record keeping.  Installation and 
operation of this software package is described in the 
following sections. 
 
Note: Please note that the figures and functions shown in 
this section are from the model PGM-7800.  For the model 
PGM-7840, the basics are the same as the PGM-7800.  
However, in PGM-7840 the oxy sensor is replaced with 
another toxic sensor.  Therefore, any figures or descriptions 
related to “Oxy” sensor in this section will be replaced by  
“Tox 4” sensor. 
Also, any figures that show “7800” will be replaced by 
“7840”, for the model PGM-7840. 
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5.1 Install ProRAE-Suite Software 
 
ProRAE-Suite software package is supplied with the VRAE 
datalogging monitor.  This software package is available on 
3.5” setup diskettes.  To install the ProRAE-Suite software, 
insert the first setup diskette into the “A” or “B” floppy disk 
drive.  Click the Start button on the taskbar to display the 
start menu, then click the Run from the start menu to display 
the Run dialog box. If the setup diskette is in disk drive A, 
type A:\Setup.exe in the Open field, as shown in Figure 5.1. 
  

 
 

Figure 5.1   Run Dialog Box 
 
Press the Enter key on the keyboard or click the OK button 
on the menu to start the setup process.  If the user choose 
the default settings in every steps of the process, the 
ProRAE-Suite software package will be installed under the 
default directory:  C:\Program Files\RAE Systems 
Inc\ProRAE-Suite.  After the software is installed 
successfully, a new menu item ProRAE-Suite is added to 
the Programs menu.  To start the ProRAE-Suite software, 
click the Start button on the taskbar to display the Start 
menu, click the Programs menu item to display the 
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Programs submenu, then click the ProRAE-Suite menu 
item to display the ProRAE-Suite submenu.  There are two 
submenu items under the ProRAE-Suite submenu: 
ProRAE-Suite and Readme, as shown in Figure 5.2.  Click 
the ProRAE-Suite submenu item to start the ProRAE-Suite 
software. 
 

 
 

Figure 5.2   Start Menu 
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5.2 Connect VRAE to PC  
 
The basic kit of VRAE datalogging monitors includes a 
serial interface cable.  Connect the DB-9 connector side of 
the cable to the serial port of the PC, and connect another 
side of the cable to the serial connector of the VRAE 
monitor. 
 
Turn on the power to the VRAE monitor.  Press the 
[MODE] key several times until the LCD shows “PC 
Comm…?”  Press the [Y/+] key and the display shows 
“Monitor will Pause, OK?”  Press [Y/+] key to confirm and 
the display shows “Ready...” to indicate that the VRAE 
monitor is ready for communication with PC.  During the 
communication session, the PC will directly control the 
VRAE monitor through the serial link.  There is no need to 
press any key on the VRAE monitor during the 
communication session. 
 
  
Note:  Do not connect to the parallel port of the PC by 
mistake.  The parallel port is usually a 25 pin female D 
connector on the back of the PC, the serial port is usually a 
25 or 9 pin male D connector.  If the serial port on the PC 
is a 25 pin connector, the user needs to use a 25 pin to 9 pin 
adapter in order to accept the serial cable.  
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5.3 Start ProRAE-Suite Software 
 
To start the ProRAE-Suite software, click the Start button 
on the taskbar to display the Start menu, click Programs -> 
ProRAE-Suite -> ProRAE-Suite submenu item to start the 
ProRAE-Suite software.  Figure 5.3 shows the main window 
of the ProRAE-Suite software. 
 

 
 

Figure 5.3   ProRAE-Suite Main Window 
 
The functions of ProRAE-Suite software can be divided into 
three categories: 
 
1) Configuration data category.  This category includes 

editing the configuration data file, sending the 
configuration data to the VRAE monitor and receiving 
the configuration data from the VRAE monitor, etc. 

 
2) Logged data category.  This category includes receiving 

the logged data from the VRAE monitor, displaying the 



COMPUTER INTERFACE  

5 - 6 

logged data in different format, exporting the logged data 
to a tab delimited text file so that it can be read by the 
Microsoft Excel software, etc. 

 
3) Upgrade category.  This category includes upgrading the 

datalog feature of the VRAE monitor, enable/disable the 
serial printer option, customize the power-on messaging 
and upgrading the firmware in the VRAE monitor. 

 
There is a tool bar beneath the menu bar.  The frequently 
used functions are represented in this tool bar in the form of 
a small icon.  For example, the Receive data function in the 
Communication sub-menu is represented as a small arrow 
with the letters “RECV.”  When the mouse cursor (a small 
arrow) is positioned near each icon in the tool bar, a short 
text will also appear at the bottom of the Window to 
describe the function of this icon. 
 
This tool bar allows the users to invoke a function 
conveniently by clicking on the icon without going through 
the sub-menus.   
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5.4 Setup Communication Port 
 
It is necessary to setup the communication port on the 
ProRAE-Suite software so that the VRAE monitor can 
communicate with the PC correctly.  Figure 5.4 shows the 
Setup Port dialog box.  Choose the appropriate port 
according to the PC’s serial port setup. 
 

 
 

Figure 5.4   Setup Port Dialog 
 
Note:  In most PC's, there are two serial ports.  Make sure  
the serial port selected in the Setup Port dialog box 
matches the actual serial port connected to the VRAE 
monitor.  The default serial port for ProRAE-Suite is 
COM1.  If a incorrect serial port is selected, a message  will 
appear indicating that no acknowledge response received by 
the software. 
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5.5 Process the Configuration Data 
The ProRAE-Suite software allows the user to edit the 
configuration data, send the configuration data to the VRAE 
monitor, and receive the configuration data from the VRAE 
monitor. The following subsections describe the detail of 
each operation. 
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5.5.1 Edit the Configuration Data 

 
From the main menu of the ProRAE-Suite software, select 
the Open menu item from the File dropdown menu, or click 
the Open toolbar button, a dialog box appears.  Select the 
“Files of type:” to be “*.CFG” as shown in Figure 5.5. 
 

 
Figure 5.5   Open Dialog Box 

 

There should be one or more configuration files in the file 
list.  Each configuration file has a file extension of “.CFG”.  
There is one generic VRAE configuration supplied with 
ProRAE-Suite software: Default_VRAE7800_V###.CFG, 
where ### is the version number of the default configuration 
file.  
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For example, Default_VRAE_V109.cfg means this file is 
for VRAE monitor and its version is V1.09.  Choose a 
configuration file by highlighting the file name and press the 
Enter key or click the OK button on the dialog box.   
Once the configuration file is open, the configuration data is 
displayed in the newly opened client window, as shown in 
Figure 5.6. 

 
 

Figure 5.6   Displayed Configuration Data 

To edit the opened configuration data file, click the Edit -> 
Configuration menu item or the Configuration toolbar 
button to open the Edit Configuration File dialog box, as 
shown in Figure 5.7. 
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Figure 5.7   Edit Configuration File Dialog Box 

 
The Edit Configuration File dialog box contains three tab 
pages:  General , Gas Parameters and Gas Selection.  To 
change a specific configuration setting, click the 
corresponding tab page header to bring that tab page to the 
front, then change the configuration setting on that tab page.  
When finished editing the configuration settings, click the 
OK button to close the Edit Configuration File dialog 
box.  The new values of the configuration settings will be 
reflected in the client window. 
 
The General  tab page, shown in Figure 5.8, allows the user 
to change the general settings of the configuration data.  The 
following is the description of each field in the General  tab 
page of the Edit Configuration File dialog: 
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Figure 5.8   General Settings Tab Page 

ID: 
This section sets the identification that is used throughout 
the datalog process.  Both editing fields, Site and User, can 
hold up to eight alphanumeric letters. 

Security Level: 
There are three levels of security.  They are used to provide 
protection against unauthorized changes to monitor settings 
through the programming menu of the VRAE.   

Level 0 allows the user to enter the programming menu 
without password checking, but does not allow changes to 
alarm limits, real time clock, correction factor, or user and 
site information, etc.  The user can still perform 
calibrations.  

If Level 1 is selected, a four-digit password is required to 
enter the programming menu. 
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If Level 2 is selected, the programming menu may be 
entered without restriction.  Any changes made in the 
programming menu can be saved. 

Password: 
The four-digit password must be entered if level 1 is 
selected as the security level or the monitor is in the Text 
mode.  Entry to the programming menu requires that this 
password be entered. 
 
User mode: 
In the Text mode, the monitor only displays the sensor name 
and an OK message during normal operation.  In the Display 
mode, the user can view several readings in the normal 
operation, but cannot enter the programming menu.  In the 
Program mode, the user can enter the programming mode 
to calibrate the monitor or change various settings in the 
monitor. 
 
Warm-up Time: 
This option allows the user to choose the warm-up time of 
the instrument, in seconds. 
 
Comfort Beep: 
This option allows the user to specify a time interval that the 
buzzer will beep once to remind the user that the monitor is 
on.  If zero is entered for the time interval, then the security 
beep feature is disabled. 
 
Back Light: 
This option allows the user to choose to turn on and off the 
LCD backlight manually or automatically based on the 
ambient light sensor input.  If Manual  mode is selected, the 
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user can also enter a time out period so that the backlight 
will be turned off automatically after the time out period.  If 
Auto is selected, the ambient light sensor will automatically 
turn on and off the backlight. 
 
Clock from PC: 
This option allows the PC clock to be downloaded to the 
VRAE monitor so that the user does not need to manually 
set the clock in the VRAE monitor. 
 
Pump Speed: 
This option allows the user to choose the high or low pump 
speed for the VRAE monitor. 
 
Measure: 
The user can choose to record the average or peak (Max) 
reading of all the sensors during each datalog period.  
 
Datalog Interval: 
The datalog interval is the rate at which datalog samples are 
recorded while the datalog is running.  The unit of datalog 
interval is second.  The datalog interval determines how 
often a new sample is calculated and stored to the datalog. 
 
Datalog Selection: 
The user can choose one or more sensors for datalogging 
purpose.  This does not activate or inactivate the particular 
sensor except for the purpose of datalogging recording. 
 
Datalog Mode: 
This may be set to either of four choices: 
-- With Automatic start/stop, the datalogging begins when 
the monitor is turned on and ends when it is turned off. 
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-- With Manual start/stop, the datalog can begin by a series 
of key presses in the menu of normal operation.  The 
maximum run time determines an automatic end to the 
datalog or it can be stopped manually.  
-- If Periodic start /stop (or daily) mode is chosen, the 
user must specify the start and stop hour and minute.  The 
interval between start and stop is the period of time the 
monitor will datalog (at “data logging period” rate). 
-- With Scheduled start/stop, all the entry boxes for year, 
month, day, hour and minute for both start and stop time 
must be entered to specify when the datalog is to occur. 
 
Run Time: 
If manual start/stop mode for datalogging is chosen, the user 
needs to specify a maximum run time.  After the monitor has 
been on for the specified run time, datalogging will be 
turned off automatically. 

 
Start Time and Stop Time: 
If scheduled start/stop mode is chosen for datalogging, all 
entry boxes must be completed for start and stop year, 
month, day, hour and minute.  The monitor must already be 
turned on.  Then once the start date/time is reached, the 
monitor will start datalogging.  When the stop date/time is 
reached, the datalogging will stop automatically.  With 
periodic start/stop mode, the hours and minutes are used for 
the data log period to be run each day. 
 
Figure 5.9 shows the Gas Parameters tab page that allows 
the user to change the gas parameters of the configuration 
data.  The following is the description of each field in the 
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Gas Parameters tab page of the Edit Configuration File 
dialog:  
  

 
Figure 5.9   Gas Parameters Settings Tab Page 

Tox1 Alarm Levels (ppm):   
This is the place where the user can specify the STEL alarm 
level (ppm), TWA alarm level (ppm), low alarm level (ppm) 
and high alarm level (ppm) for Tox1 sensor. 
 
Tox2 Alarm Levels (ppm):   
This is the place where the user can specify the STEL alarm 
level (ppm), TWA alarm level (ppm), low alarm level (ppm) 
and high alarm level (ppm) for Tox2 sensor. 
 
Tox3 Alarm Levels (ppm):   
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This is the place where the user can specify the STEL alarm 
level (ppm), TWA alarm level (ppm), low alarm level (ppm) 
and high alarm level (ppm) for Tox3 sensor. 
 
OXY Alarm Levels (%):   
This is the place where the user can specify the low alarm 
level (%) and high alarm level (%) for OXY sensor. 
Note:  For PGM-7840, OXY Alarm Level will be replaced 
by Tox4 Alarm Levels (ppm). 
 
LEL Alarm Levels (%): 
This is the place where the user can specify the low alarm 
level (%) and high alarm level (%) for LEL sensor. 
 
VOL Alarm Levels (%): 
This is the place where the user can specify the low alarm 
level (%) and high alarm level (%) for VOL sensor. 
 
Alarm mode: 
If Auto Set (Auto reset) is chosen, the alarm will stop as 
soon as the alarm condition goes away.  The alarm will 
remain on if the Latched option is chosen.  To turn off a 
latched alarm, press [Y/+] key to acknowledge the alarm 
condition. 
 
Power On Zero: 
This option allows the monitor to perform a fresh air 
calibration automatically when the monitor is turned on.  
Care must be taken, when using this mode, to ensure that the 
monitor is in a fresh air environment when turned on. 
 
Calibration span: 
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The user can specify the calibration gas span for Tox1, Tox2, 
Tox3, OXY, LEL and VOL here.  Note:  In PGM-7840 
model, the OXY span entry will be replaced by Tox4 entry. 
 
Figure 5.10 shows the Gas Selection tab page.  There is one 
set of gases for correction factors that the user can choose 
for the LEL sensor. The following is the description of each 
field in the Gas Selection tab page of the Edit 
Configuration File dialog box: 

 

 
Figure 5.10   Gas Selection Settings Tab Page 

 
LEL Current Gas selection:   
This is the place where the user can choose a set of gases for 
correction factors of the LEL sensor.  The user can choose 
one gas from the Calibration Gas list box for calibration 
and another gas from the Measurement Gas list box for 
measurement.  Each list box contains a list of about 40 
gases.  Scroll the list using the up or down arrow until the 
desired gas name is shown.  Press Enter key to select the 
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gas.  The user can also enter a custom gas name (up to 16 
characters long) and a custom correction factor. 
 
OK/Cancel: 
When the configuration changes are completed, click on the 
OK button to save the configuration and return to the client 
window.  Click on Cancel button to abort the configuration 
changes. 

Figure 5.11 shows the Other tab page. This page contains 
two features: Power On Messaging and On-line Printing. 

Figure 5.11   The Other Tab Page 

Power On Message:  It is a feature that allows  the user to 
display any custom message, up 16 characters, when 
powering up the gas monitor.  For example, the user can 
enter the name of the company which own the gas monitor. 
The default message stored inside every VRAE gas monitor 
is “RAE systems Inc.”  To change the default, simply type in 
the desire message in the text bracket. 
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On-line Printing:  It is an option that requires a RAE 
specified serial printer.  This feature allows the user to 
retain a hard copy of the instantaneous reading. To utilize the 
printer option, the user must first enable the On-line 
printing.  Once the On-line printing is enabled, a new sub-
menu item will appear in the user mode (see Section 2.4 for 
more details). 
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5.5.2 Send Configuration to VRAE 

 
After the configuration data is loaded into the ProRAE-Suite 
software, the user can send the configuration settings to the 
VRAE monitor.  To send the configuration settings to the 
instrument, click Communication->Send Config menu 
item or click the send toolbar icon (right arrow with “Send” 
letters), a message box will appear to remind the user to 
connect the instrument to the PC through the serial port. 
After making sure that the instrument is connected to the 
PC, click the OK button to start the data transfer. 
  
After the configuration information is sent successfully, a 
message box will appear to indicate that the sending 
configuration process is completed.  Click the OK button to 
close the message box. 
 
If the communication is not successful, an error message 
indicating that there is no response from the instrument will 
appear.  Check the cable to make sure that the connectors on 
both ends of the cable are securely seated in the sockets.  
Try to send the information again.  If the error message still 
appears after repeated attempts, call an authorized service 
center for help. 
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5.5.3 Receive Configuration Data 

 
To receive the configuration data from the VRAE monitor, 
click Communication->Receive Config menu item, a 
message box will appear to remind the user to connect the 
instrument to the PC through the serial port.  After making 
sure that the instrument is connected to the PC, click the 
OK button to start the data transfer.  After the data transfer 
is finished, a new client window is opened with the newly 
received configuration data displayed.  In order to save the 
configuration information for future use, user can click 
File->Save or File->Save As  menu item to save the newly 
received configuration data to a file. Once the configuration 
file is saved on disk, it can be opened at a later time for 
further modification or be sent to the VRAE monitor. 
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5.5.4 Configure All Settings 

 
The user can use this function to update the entire 
configuration settings (except the instrument ID, serial 
number and the datalog option) in the VRAE monitor.  To 
configure all the settings in the instrument, click Option-
>Config All menu item, a message box will appear to 
remind the user to connect the instrument to the PC through 
the serial port.  After making sure that the instrument is 
connected to the PC, click the OK button, another message 
box will appear to warn the user that this operation will erase 
all the old configuration settings instrument.  If the user 
does not want this to happen, clicks the Cancel button, 
otherwise, click the OK button to start the data transfer. 
  
After the information is sent successfully, a message box 
will appear to indicate that the sending configuration process 
is completed.  Click the OK button to close the message 
box. 
 
Note:  The Config All option is mainly used to restore the 
VRAE monitor’s default operational settings, such as 
calibration data, lamp & pump drive, and diagnostic 
parameters, etc.  If the user feel that the internal calibration 
data of the instrument are corrupted or incorrect and can not 
be recovered, then user can open the default configuration 
file and use this option to restore the instrument to a known 
state. 
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5.6 Process the Logged Data 
 
The ProRAE-Suite software allows the user to retrieve the 
logged data from the VRAE monitor and display the data in 
many different formats.  The user can also export the 
displayed text to a tab delimited text file so that Microsoft 
Excel can read it directly. 

 



COMPUTER INTERFACE  

5 - 25 

5.6.1 Receive Data from VRAE       

 
To receive the logged data from the VRAE, click 
Communication->Receive Data menu item or click the 
Receive Data toolbar button (left arrow with “Recv” 
letters), a message box will appear to remind the user to 
connect the instrument to the PC through the serial port.  
After making sure the instrument is connected to the PC, 
click the OK button to start the data transfer.  After the data 
transfer is finished, a new client window is opened with the 
newly received logged data displayed.  In order to save the 
logged data for future use, the user can click File->Save or 
File->Save As  menu item to save the newly received logged 
data to a file. 
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5.6.2 View Logged Data in Text Mode 

 
Once the user opened a data file or received the logged data 
from the instrument, a data window appears, as shown in 
Figure 5.12. 
   

 
Figure 5.12   Displayed Logged Data 

 
The data window is a two-pane client window.  The left pane 
is a tree which all the display format of each event, and the 
right pane displays the information according to the display 
format and the event the user selected on the left pane.  To 
select any display format of any event, the user can simply 
click the format item on the left pane.  To view the next 
event or the previous event, the user can click the Next 
Event (double right arrow) or the Previous Event (double 
left arrow) toolbar buttons.  The user can also drag the 
splitter bar between the left pane and the right pane to the 
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left or to the right to enlarge a pane if that pane is not big 
enough. 
 
To view the data points of a specific event, the user can click 
the item representing that event under the item Data\Text 
Mode.  For example, click the item Event #1 on the left 
pane, the right pane displays the data points of event #1, as 
shown in Figure 5.12. 
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5.6.3 View STEL/TWA/AVG Value 

To view the STEL, TWA or AVG value of any event, click the 
event number item under the tree item STEL/TWA/AVG in 
the left pane, the right pane displays the STEL, TWA and 
AVG value of each data point of that event, as shown in 
Figure 5.13. 
 

 
Figure 5.13   STEL/TWA/AVG of the Logged Data 
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5.6.4 View Summary Information 

 
To view the summary information of any event, such as peak 
data value and minimum data value, click the event number 
item under the tree item Summary in the left pane, the right 
pane displays the summary information of that event, as 
shown in Figure 5.14. 
 

 
 

Figure 5.14   Summary Information of the Logged Data 
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5.6.5 View Logged Data in Graph Mode 

 
To view the logged data of a specific event in graph mode, 
click the event item under the tree item Graph Mode in the 
left pane, and the right pane displays the graph of that event, 
as shown in Figure 5.15. 
 

Figure 5.15   Graph of the Logged Data 
 

Select graph type:   
The user can choose the type of sensor data in the Graph 
Type tab page of the Graph Settings dialog box.  To display 
the Graph Settings dialog box, click any place in the right 
pane so that pane has the focus, then click Option->Graph 
Settings menu item to display the Graph Settings dialog 
box.  Figure 5.16 shows the Graph Type tab page of the 
Graph Settings dialog box.  This is the place where the user 
can choose which sensor data to be shown on the graph, 
whether to show grid on the right pane, and the title of the 
graph. 
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Figure 5.16   Graph Type Tab Page 

Select graph range:   
The user can choose the value range on the x-axis and y-axis 
in the Graph Range tab page of the Graph Settings dialog 
box.  To display the Graph Settings dialog box, click any 
place in the right pane so that pane has the focus, then click 
Option->Graph Settings menu item to display the Graph 
Settings dialog box.  To bring the Graph Range tab page, 
the user can simply click the page header of the Graph 
Range tab page.  Figure 5.17 shows the Graph Range tab 
page of the Graph Settings dialog box.  This is the place 
where the user can choose the graph range on the x-axis and 
y-axis. 
 
To choose the range of Y-axis, the user first click the User 
Defined radio button in the Y-Axis (Data Value) Range 
group box, then the user can specify the top value and the 
bottom value in the Data Value Range (Y-axis) group box. 
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Figure 5.17   Graph Range Tab Page 

 
If the user select the Default radio button in the Y-Axis 
(Data Value) Range group box, the ProRAE-Suite software 
will scale the range of Y-axis by itself to cover the 
maximum data value on y-axis. 
 
To choose the range of X-axis, the user first click the User 
Defined radio button in the X-Axis (Data Time) Range 
group box, then specify the start time fields in the Start 
Time (X-axis) group box and the end time fields in the End 
Time (X-axis) group box. 
 
If the user select the Default radio button in the X-Axis 
(Data Time) Range group box, the ProRAE-Suite will scale 
the range of X-axis by itself to cover the every data points 
on x-axis. 
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5.6.6 Export the Displayed Data to a Text File 

 
The ProRAE-Suite software allows the user to export the 
displayed text to a tab delimited text file so that Microsoft 
Excel can read it directly.  To export the text displayed in 
the right pane to a tab delimited text file, click Option -> 
Export Text menu item, a Save As dialog box is displayed.  
Specify the file name in the File name field, then click the 
OK button to close the Save As  dialog box.  A new file is 
created and Microsoft Excel can read this file directly.  
Appendix C shows a detailed step by step instruction on how 
to export data as text file and use Microsoft Excel to open 
the text file. 
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5.6.7 Export a Graph to a File 

 
The ProRAE-Suite software allows the user to export the 
displayed graph to a windows bitmap (.bmp) file or a 
windows metafile (.wmf) file.  To export the displayed graph 
in the right pane to a windows bitmap or metafile file, first 
click any place in the right pane to make sure that the graph 
pane has the focus, then click Option -> Export Graph 
menu item to display a Save As  dialog box.  Select the 
export graph file type (.bmp or .wmf) in the Save as type 
field, then specify the export file name in the File name 
field.  Click the OK button to close the Save As  dialog box.  
The newly created graph file contains the graph displayed in 
the right pane. 
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5.6.8 Print the Logged Data 

 
After viewing the data results, the user may print the data to a 
printer in order to obtain a hard copy of the text or graphic 
data report.  First, click any place in the right pane to set the 
focus on that pane, then select File->Print menu item, or 
click the Print toolbar button (a printer) to print the graph 
or text data.   
 
A printer setup dialog box will appear before the printing 
starts so that the paper size, orientation, printer type, etc. can 
be configured correctly.   
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5.7 Upgrade the Datalog Option 
 
To upgrade the unit to datalogging capability, open the 
ProRAE-Suite software.  Do not open any configuration file 
or data file so that the ProRAE-Suite software has no client 
window open, as shown in Figure 5.18. 
 

 
 

Figure 5.18   Main Window of ProRAE-Suite 
 
Click Option -> Enable Datalog menu item, a message box 
will appear to remind the user to connect the instrument to 
the PC through the serial port.  After making sure that the 
VRAE monitor is connected to the PC, click the OK button 
to start.  After the ProRAE-Suite software makes successful 
contact to the instrument connected to the PC, a dialog box 
is displayed, as shown on Figure 5.19. 
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Figure 5.19   Enable Datalog Dialog Box 

 
Figure 5.19 shows that the instrument’s datalog feature is 
currently disabled. To enable the datalog capabiltiy, click the 
“Enable” button, type the three-digit authorization code in 
the Authorization Code field, and then click the OK button 
to close the dialog box.  After the datalog option is changed, 
a message box will appear on the screen to let the user know 
that the datalog option is successfully changed. 
 
Note:  Each VRAE with datalogging function should be 
shipped with a 3-digit authorization code.  If the code is 
missing, call the factory’s Customer Service Department to 
obtain the code.  If the unit is being upgraded from non-
datalogging to datalogging, call an authorized distributor to 
purchase this feature. 
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5.8 Upgrade the Firmware 
Recent Firmware upgrades are available at no cost on the 
RAE website www.raesystms.com. To upgrade the firmware 
in the VRAE monitor, open the ProRAE-Suite software.  Do 
not open any configuration file or data file so the ProRAE-
Suite software has no client window open, as shown in 
Figure 5.18.  Click Option -> Load Firmware menu item, 
a message box will appear to remind the user to connect the 
instrument to the PC through the serial port.  After making 
sure that the instrument is connected to the PC, click the 
OK button.  An Open file dialog box is displayed, as shown 
on Figure 5.20.  Select the firmware file (.a07) that is going 
to be loaded into the instrument, click the OK button to start 
the loading process.  After the firmware loading is finished, 
a message box will appear on the screen to let the user know 
that the firmware is successfully loaded into the instrument. 
 

 Figure 5.20   Open Firmware File Dialog Box 
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6 THEORY OF OPERATION 

VRAE monitor uses up to five different sensors to measure 
a variety of gases.  A newly developed thermal conductivity 
sensor is combined with a catalytic combustible gas sensor 
(See Figure 6.1).  The thermal conductivity sensor will 
detect a broad range of gases.  Up to three electrochemical 
toxic gas sensors (four in PGM-7840 model) can be 
installed in the monitor to measure inorganic toxic gases.  
Many different type of toxic sensors are offered.  They can 
be plugged into these three sensor sockets and are 
interchangeable.  An electrochemical sensor is used to 
measure oxygen concentration in PGM-7800 model.  

 
 

 

 
 

 

 

 

 

 

 

Figure 6.1   Block Diagram of VRAE PGM-7800 Monitor 
 
The five sensors are mounted next to the gas inlet probe.  A 
diaphragm pump is installed inside the monitor to draw the 
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sample air into the sensor manifold and then distributed it to 
all sensors.  
 
A single chip microcomputer is used to control the 
operation of the alarm buzzer, LED, pump and light sensor.  
It measures the sensor readings and calculates the gas 
concentrations based on calibration to known standard gases.  
The data is stored in non-volatile memory so that it can be 
sent to a PC for record keeping.  RS-232 transceivers 
provide a serial interface between the monitor and the serial 
port of a PC.  A 2-line by 16-character LCD display is used 
to show the readings.  The user interacts with the monitor 
through three keys on the front panel keypad. 
 
The monitor is powered by a rechargeable NiMH battery or 
an alkaline pack, for portability.  
 

NOTE:  The printed circuit board of the monitor is 
connected to the battery pack even if the power is 
turned off.  Therefore, it is very important to disconnect 
the battery pack before servicing or replacing sensors 
or any components inside the monitor.  Severe damage 
to the printed circuit board may occur if the battery 
pack is not disconnected before servicing the unit.  
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7 MAINTENANCE 
 
As shown in Figure 7.1, the major maintenance items of 
VRAE are: 
 
 • Battery pack  
 • Sensor modules 
 • Sampling pump  
 

 
  Figure 7.1   Main Components of VRAE   
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7.1 Battery Replacement 
 

 When the display shows a flashing message “Bat”, the 
battery requires recharging.  The battery may be replaced in 
the field  (in area known to be non-hazardous) if required.  It 
is recommended to recharge the VRAE monitor upon 
returning from field work.  A fully charged battery powers a 
VRAE monitor for up to 10 hours of continuous operation.  
The charging time is less than 10 hours for a fully 
discharged battery.  The built-in charging circuit is 
controlled by two-step constant voltage / constant current 
charging to prevent over-charging.   
 
 
 
 

WARNING: 
To reduce the risk of ignition of hazardous 
atmospheres, recharge battery only in area known 
to be non-hazardous.  Remove and replace battery 
only in area known to be non-hazardous.  
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Replacing and Recharging Battery Pack 

1. Turn off power of the VRAE. 
 
2. Refer to Figure 7.1, unscrew two case screws from the 

bottom of the monitor case and remove the battery 
cover.   

 
3. Remove the battery pack from the battery compartment. 
 
4.  Place a new battery pack in the battery compartment.  

Make sure that the contacts on the battery pack matches 
with the battery pins inside the compartment. 

5.  Close the battery cover and tighten the screws. 

 
Replacing Alkaline Battery Adapter 
1. Insert four fresh AA size alkaline batteries into the 

alkaline battery adapter.  Make sure that the polarity of 
the battery is correct. 

 
2. Follow the same procedure as described above to replace 

the battery adapter.  
 
Note:  The internal charging circuit is designed to prevent 
charging to alkaline batteries when alkaline batteries are 
installed inside the monitor. 
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7.2 Sensor Replacement  
The toxic, combustible and oxygen sensors all have an 
expected operating life.  Under normal operating condition, 
most sensors will lose its original sensitivity after the 
expected operating life and needs to be replaced.   
 

Each sensor module in VRAE includes a non-volatile 
memory that records the manufacturing date of the sensor.  
In the diagnostic mode, the microprocessor will check the 
date code and display the expiration date of each sensor.  
The user should replace the sensor when the current date 
exceeds the expiration date of a sensor. 

 
Sensor Replacement Procedure 
The oxygen and combustible sensor each has its unique 
sensor sockets in the VRAE monitor.  The three toxic sensor 
sockets in the VRAE monitor allow the users to plug in any 
three sensors selected from the series of toxic sensors 
offered by RAE Systems Inc.   
 
1. Turn off power of the VRAE.  
 
2. Refer to Figure 7.1, open the battery cover by unscrew 

the two screws from the bottom of the monitor case.  
Remove the battery pack. 

 
3. Open the bottom cover of the monitor case by removing 

the 6 screws that holds the bottom case. 
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4. Refer to Figure 7.1, carefully unscrew four No.2 screws 
that hold down the gas piping cover to the PCB and 
sensors.  Remove the gas piping plate. 

 
5.  Refer to Figure 7.1, identify the location of a specific  

sensor and remove the sensor by gently pulling the 
sensor upward. 

 
6.  Plug a new sensor into the empty sensor socket.  Make 

sure that black line on the sensor label is lined up with 
the white marker on the PCB and the sensor pins are 
aligned with the socket before pushing down the sensor. 

 
7. Replace the gas piping cover and tighten the four screws 

to hold down the sensors.  Replace the battery pack and 
the monitor cover. 

 
8. Turn on the power of the VRAE.  The microprocessor 

will automatically recognize the sensors installed and 
configure the monitor accordingly. 

 
Special Bias Voltage for Toxi c Sensor: 

The NO and NH3 toxic sensors require a special 300 mV 
bias voltage to operate.  There is a dip switch located on the 
PCB next to the sensors.  When NO or NH3 toxic sensor is 
plugged into the toxic sensor socket, it is necessary to turn 
the dip switch for the corresponding sensor to “ON” 
position to enable the bias voltage.  It is very important to 
set the bias switch to the correct position when installing the 
toxic sensors. 
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7.3 Sampling Pump Replacement 
 
The sampling pump is positive displacement piston pump.  
When approaching the end of the specified life time of the 
pump, it will consume higher amount of energy and reduce 
its sample draw capability significantly.  When this occurs, it 
is necessary to replace the pump. 
 
1. Turn off power of VRAE gas monitor. 
 
2. Refer to Figure 7.1, open the monitor cover, remove the 

battery pack, carefully unscrew four No.2 screws that 
hold down the gas piping plate to the PCB and sensors.  
Remove the gas piping plate. 

 
3. Pull loose the connector of the pump wire.  Unscrew the 

two screws that hold the pump assembly to the PCB.  
Disconnect the Tygon tubing that connects the pump to 
the gas inlet port. 

 
4. Replace a new pump assembly.  Connect the Tygon 

tubing to the gas inlet port.  Connect the pump wire and 
screw down the pump assembly to the analog PCB.  

 
5. Refer to Figure. 7.1, replace the gas piping plate and 

tighten the four screws to hold down the sensors.  Re-
place the battery pack.  Replace the battery cover. 
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8 TROUBLESHOOTING 
 
To aid the user in diagnosing the monitor, the monitor has a 
special diagnostic mode that can display critical, low level 
parameters.  Section 8.1 describes the operation of the 
diagnostic mode.  Section 8.2 summarizes the frequently 
encountered problems and suggested solutions.  Turning on 
the VRAE monitor in diagnostic mode and using the 
troubleshooting table in Section 8.2, the user can usually 
narrow the problem down to one or two areas and correct the 
problem without having to return the monitor for repair. 
 
WARNING:  The diagnostic mode allows the user to set 
several low level parameters that are very critical to 
the operation of the monitor.  Extra care should be 
taken when setting these low level parameters.  If the 
user are not familiar with these parameters and set 
them incorrectly, it may cause the monitor to shut down 
or malfunction. 
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8.1 Special Diagnostic Mode 
 
To place the monitor into the special diagnostic mode, first 
turn the monitor off.  Next push and hold the [Y/+] key, while 
still holding the [Y/+] key, also push and hold the [MODE] 
key for at least two seconds.  After the required delay, 
release both keys, the monitor will now go through the 
normal start-up display sequence and display a “Diagnostic 
mode” message.  At the end of the special mode start-up, the 
display will show 1 to 5 numbers with a message “Raw.”  
These numbers are raw sensor readings without calibration. 
 

Other critical parameters of the monitor are available as 
shown in Table 8.1.  They can be reached by pressing the  
[MODE] key repeatedly until the desired parameters are 
displayed. 
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       Table 8.1

Key Action Display 
 Show raw readings 
[MODE] Show sensor name 
[MODE] Show battery type and battery temperature  
[MODE] Adjust LCD contrast 
[MODE] Show LEL or VOL sensor raw readings 
[MODE] Show date, clock, battery voltage and 

temperature  
[MODE] Show LEL & OXY sensor expiration date  
[MODE] Show TOX1 & TOX2 sensor expiration date  
[MODE] Show TOX3 sensor expiration date  
[MODE] Adjust pump stall  threshold 
[MODE] Adjust back light on/off threshold 
[MODE] Show serial number and toggle pump speed 
[MODE] Begin battery deep discharge 
[MODE] Show battery duration time 
[MODE] Communicate with PC? 

 
 
 
 
 
 
 
 
 
 
Below is a brief description of each diagnostic display and 
how to interpret the displayed values: 
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1) Raw Sensor Readings 
The raw sensor readings provide a quick diagnosis on the 
baseline and sensitivity of each sensor.  When zero gas 
(fresh clean air) is applied to the monitor, the raw sensor 
readings typically should be between 100 to 300 for toxic   
sensors, between 1800 to 2600 for LEL or VOL sensor and 
between 800 to 1200 for oxygen sensor.  If the raw reading 
is outside these ranges when zero gas is applied, the sensor 
or the electronics may be defective. 
 

When a specific gas is applied to the monitor, the 
corresponding sensor should respond and the raw reading 
should increase or decrease.  If the reading of the 
corresponding sensor does not change when the specific gas 
is applied, then the sensor may be defective.   
 

165      160   173 

2051     RAW      1079 
 

2) Sensor Name 
All the toxic, oxygen and LEL sensors have a non-volatile 
memory which contains the sensor identification and other 
vital information, such as manufacturing date, expected 
operating life, etc.  If a sensor is programmed and installed 
properly in the monitor, the sensor name should be 
displayed.  If the sensor name does not show up in the 
display, then the sensor may not be programmed properly or 
may be defective. 

3) Battery Type and Battery Temperature 
The VRAE monitor can be powered by either a rechargeable 
NiMH, Ni-CD battery pack or an alkaline battery adapter.  
The microprocessor automatically detects the type of 
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battery installed inside the monitor and displays the type of 
battery. The re–chargeable battery includes a temperature 
sensor.  The temperature sensor reading is also displayed.  
 

4) Adjust LCD Contrast 
This display allows the user to adjust the LCD contrast.  
Press [Y/+] to increase the contrast and [N/-] key to 
decrease the contrast.  The bar graph shows the current LCD 
contrast setting.  If the display appears blank, press [Y/+] 
key several times should see a more clear display. 
 

5) Display LEL or VOL Raw Reading 
This display shows the present raw reading of the LEL or a 
combination of LEL/VOL sensor.  The top display shows the 
mode of the combustible sensor.  The bottom line shows the 
instantaneous reading of raw counts from the LEL or VOL 
sensor.  By pressing [N/-] key the sensor mode can be 
switched from %LEL to %VOL and vice versa. If a standard 
LEL sensor is installed, press [N/-] key will toggle on and 
off the LEL sensor. 
 

6) Show Clock, Battery and Temperature  
This display shows the real time clock, battery voltage in raw 
count and temperature sensor reading.   

 

 
 

7) Sensor Expiration Date 
This display shows the expiration date (month and year) of 
all the installed sensors in the VRAE monitor.  The 
expiration date is calculated based on the manufacturing date 
and expected life of each sensor which were stored inside 
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each sensor when it was fabricated in the factory.  If the 
current date exceeds the expiration date of any sensor, the 
performance of the given sensor can no longer be 
guaranteed.  It is strongly recommended that the user replace 
the sensor immediately to ensure proper operation of the 
sensor. 
 

8) Adjust Pump Stall Threshold 
This display can be used to calibrate the pump stall 
threshold.  If the gas inlet is blocked but the pump does not 
shut down, or the pump shut down too easily with a slight 
blockage to the gas inlet, then the pump stall threshold value 
may be set too high or too low.  Use the following steps to 
adjust the pump stall threshold. 
 
1. The maximum and average pump current is displayed on 

the first row:  “Pump = xxx/zzz”.  The current pump stall 
value is displayed on the second row: “Stall = yyy +/-”.  
The typical maximum and average pump current without 
any blockage should be between 8–10.  The typical stall 
value should be higher than the “un-blocked” pump 
current by at least 8-10 counts.   

2. The user can block the gas inlet and watch the pump 
current reading.  If the pump current reading does not 
increase significantly (i.e. more than 3–5 counts), then 
there may be a leak in the gas inlet or the weak or 
defective.   

3. Use [Y/+] or [N/-] key to increase or decrease the stall 
value until it is about 8-10 counts above the “un-blocked” 
pump current reading.  Press [MODE] key to exit this 
display.  If the threshold value is changed, a message 
“Save new stall threshold?” will appear.  Press [Y/+] to 
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confirm the change, [N/-] or [MODE] key to abandon the 
changes. 

 

9) Adjust Back Light Threshold 
This display can be used to calibrate the LCD back light turn 
on and off threshold.  Use the following steps to adjust the 
back light threshold. 
 

1. The present ambient light level is displayed on the first 
row:  “Light = xxx.”  The current back light threshold 
value is displayed on the second row:   “Trigger = yyy +/-.”  
In a brightly lit room, the light reading should be above 
120.   

2. The user can block the light sensor, which is located at 
the upper left corner of the monitor, with a finger and 
watch the light sensor reading.  The light reading should 
drop to less than 100.  Determine the ambient light level 
when the back light should be turned on and record the 
light sensor reading.  

3. Use [Y/+] or [N/-] key to increase or decrease the trigger 
value until it is about the same as the previously recorded 
light sensor reading.  Press [MODE] key to exit this 
display.  If the threshold value is changed, a message 
“Save new light threshold?” will appear.  Press [Y/+] to 
confirm the change, [N/-] or [MODE] key to abandon the 
changes. 

 
10) Serial Number and Pump Toggle 
This display shows the unit serial number.  
  

If a pump is installed and pump speed control circuit 
available, the display “Pump=Low/(High)” may be toggled by 
pressing the [N/-] key.  Note that changes made here are 
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only for testing the pump condition and do not become saved 
in the nonvolatile memory (see Section 4.7 to update the 
pump speed setting). 
 

11) Start Battery Deep Discharge 
This display can be used to begin a battery deep discharge 
cycle.  Certain rechargeable batteries may require deep 
discharge before charging again.  
 

To start the deep discharge: First connect the charger and 
select [Y/+] key to enter the deep discharge mode and 
answer with [Y/+] key when asked to confirm.  The unit will 
turn off charger current and draw its maximum current until 
the battery voltage reaches 4.0 volts.  With the charger 
connected, a charge cycle will then begin.  
 
12) Display Battery Duration Time 
This display shows the run time of the last time the unit 
powered itself off due to a low battery or turned off by the 
user.  It is useful for battery life testing. 
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8.2 Troubleshooting Table 
 
   Table 8.2 
Problem Possible Reasons & Solutions               
Cannot turn 
on power 
after charging 
the battery 

Reasons: Discharged battery.  
                      Defective battery. 

Microcomputer hang-up. 
 
Solutions: Charge or replace battery. 

Disconnect then connect 
battery to reset computer. 

 
No LED or 
LCD back 
light 

Reasons: Defective LED or LCD back 
light. 

 
Solutions: Call authorized service center 
 

Lost 
password 

Solutions: Use default configuration to 
reset password 

  
Buzzer 
inoperative  

Reasons: Bad buzzer 
 
Solutions: Call authorized service center  
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Problem Possible Reasons & Solutions               
“Bat” 
message in 
operation 

Reasons: Discharged battery  
 

Solutions: Recharge battery 
 

“Voltage 
too high 
message” in 
charge mode 

Reasons: Battery fuse blown or wrong 
AC adapter 

 

Solutions: Check battery and adapter 
 

Excessive 
pump noise 
or no inlet air 
pressure  

Reasons: Leaky inlet path 
                   Defective pump  
 
Solutions: Check inlet connection 
                      Replace a new lamp  
 

Read a small 
background 
value 

Reasons: There is actually a small 
background gas level  

                      Sensor zero drift 
 
Solutions: Do fresh air calibration  
                      (See Section 4.4.1) 
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Reading 
abnormally  
Low 

Reasons: Incorrect calibration  
                     Low sensitivity to the specific 

gas 
 
Solutions: Calibrate the monitor 
                      Replace sensor 

 

 
Problem Possible Reasons & Solutions               
Reading 
jumping 
around 
randomly 

Reasons: Incorrect gas calibration 
                     Low sensitivity to cal gas 
 
Solutions: Calibrate the sensor 
                      Use different cal gas 
 

Can not turn 
off monitor 
or corrupted 
characters in 
LCD display  

Reasons: Microprocessor hang-up 
 
Solutions: Disconnect and re-connect 

battery to reset computer.  
Call authorized service center 

 
Calibration 
error 
message  

Reasons: No standard gas input  
                     Low sensitivity to cal gas  
  
Solutions: Make sure standard gas flows 

into monitor.  
Change cal gas 
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APPENDIX A.  QUICK REFERENCE GUIDE 
 

DISPLAY MODE/ PROGRAM MODE 
Display Instantaneous Readings 

[N]+[MODE]  for 3 seconds: 
 Security level=0 or Display Mode: No Action 
 Security level=1 or Text Mode: Password check 
  Wrong password: back to instantaneous display 
  Correct password: Enter Programming menu. 
[N]: Toggle back light [Y]: Test alarm/stop alarm 

[M] 
 Display Sensor names   
[M] 
 Display Peak values 
[M] 
 Display Minimum values   
[M] 
 Display STEL values 
[M] 
 Display TWA values   
[M] 
 Display Battery voltage  
[M] 
 Display Clock / Run time / Internal temperature 
[M] 
Configured for Manual datalog?*  

yes: Start/Stop Datalog? 
 [Y]: Start or Stop Datalog  [N]: Display Datalog mode 

 [M] 
Display LEL/VOL gas name (if sensor is present) 
 [M] 
Display Pump Speed 

[N]: Change speed 
[M] 
 LEL/VOL Mode Selection 
 [M] 
Print Reading? * 
[M] 
 Communicate with PC? 

[Y]: Monitor will pause OK? 
 [Y]: Ready...        [N]: Return to Instantaneous display 

[M] or [N] 
 Return to Instantaneous display 
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*--Display appears only if option is enabled.  
 

PROGRAMMING MODE 
Press [N] and [MODE] together for 3 seconds to enter, [Mode] to return 

 Calibrate Monitor?   (press [Y] to select menu)   

  Fresh Air Calibration?  
  Vol% Zero Calibration? 
  Multiple Sensor Calibration? 
  Single Sensor Calibration? 
  Modify Span Gas Value? 
  Change LEL/VOL Span Gas? 

 

 Change Alarm Limits?   

 Change High Alarm limit? 
 Change Low Alarm limit? 
 Change STEL Alarm limit? 
 Change Average Alarm limit? 

 

View or Change Datalog?  

 Reset Peak and Minimum? 
 Clear All Data? 
 Change Datalog Period? 
 Select Data Type? 
 View Datalog? 
 Enable/Disable Datalog? 

 

Change Monitor Setup? 

 Change Site ID? 
 Change User ID? 
 Change Alarm Mode? 
 Change User Mode?  
 Change Real Time Clock? 
 Change Backlight Mode? 
 Change Password? 
 Change Pump Speed? 
 Change Averaging Method? 
 Set Unit Temperature? 

 

Change Sensor Configuration? 

N 

Y 

Mode 

Mode 

Y 

N 

Y 

Mode 

N 

Mode 

Y 

N 

N 

N 

N 

N 
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 Change LEL/VOL Sensor Type? 
 Enable/Disable Sensor? 
 Change Dilution Ratio?  
 Change LEL/VOL Gas Selection? 

N 
Y 

Mode 

N 
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APPENDIX B.   RESPONSE INFORMATION 
 
Correction factors for a number of commonly used 
compounds for the LEL sensor are:  

 

Table B-1. Lower Explosive Limit in Vol% and LEL 
Correction Factors for LEL Sensor & LEL/TC Sensor  

Compound 
LEL Sensor 
LEL CF 

LEL/TC Sensor 
LEL CF 

LEL 
(Vol%) 

Acetaldehyde 1.8  4 
Acetic acid 3.4  4 
Acetone 2.2 4.0 2.5 
Ammonia 0.79  15 
Benzene 2.1 4.3 1.2 
Butadiene, 1,3- 2.5  2 
Butane, n- 2.0  1.9 
Carbon disulfide 3.6 5.5 1.3 
Carbon monoxide 1.2  12.5 
Cyclohexane 2.5  1.3 
Dichloromethane 1.0  13 
Ethanol 1.7  3.3 
Ethene 1.5  2.7 
Ethyl acetate 2.2 3.8 2 
Ethyl benzene 2.8  0.8 
Ethyl ether 2.3  1.9 
Gasoline, whole 2.1 3.0 1.3 
Heptane, n- 2.4 3.9 1.1 
Hexane, n- 2.3 4.3 1.1 
Hydrogen 1.2 1.7 4 
Hydrogen sulfide 2.3  4 
Isobutane 1.8  1.8 
Isobutene 2.0 2.8 1.8 
Isopropanol 1.6 2.5 2 
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Compound LEL Sensor 
LEL CF 

LEL/TC Sensor 
LEL CF 

LEL 
(Vol%) 

Methane 1.0 1.0 5 
Methanol 1.5  6 
Methyl ethyl ketone 1.7 2.6 1.4 
Octane, n- 2.9  1 
Pentane 1.8 3.4 1.5 
Propane 1.5 1.9 2.1 
Propene 1.5 2.5 2 
Toluene 1.9 4.4 1.1 
Vinyl chloride  1.8  3.6 
Xylene, m- 2.7  1.1 
Xylene, o- 3.0  0.9 
Xylene, p- 2.8  1.1 
 

The LEL correction factors are measured relative to 
methane gas.  All gases are measured at less than 5% relative 
humidity and 25oC.  These factors may change at higher 
concentration level or different temperature. The factors are 
to be multiplied by the reading to obtain the actual 
concentration or %LEL of the gas when the monitor is 
calibrated to a known %LEL of methane.  If the correction 
factor of a gas is <1.0, then the sensitivity to the gas is 
higher than that of methane. 
 

Note: The LEL CF is different when using the LEL-only 
sensor compared to the LEL/TC sensor. Therefore it is 
important to enter the proper CF in the programming mode 
when the measurement gases is changed (Section 4.8).  
Similarly, the CF for the LEL-only sensor should be 
checked for recent updates in Technical Note 156 on our 
website www.raesystems.com. 
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APPENDIX C.   VRAE DATA CONVERSION TO    
             MICROSOFT EXCEL 
 
The VRAE multi-gas monitor has a built-in 16,000 point 
datalogger that in conjunction with the ProRAE-Suite 
software will provide data that can be converted into other 
application program such as Microsoft Excel (Version 7.0 
) for further data manipulation or graphing. 

To convert the data file into Excel, and to facilitate easier 
data manipulation, the following procedure may be followed: 

1. Export the event data to a tab delimited text file, as 
described in Section 5.6.6:  Export the displayed data 
to a text file.  Assume we have just export the event data 
to a file called TextEvent.txt in C:.  To convert that file to 
a MS-Excel file, open the MS-Excel software, as shown 
in Figure C-1. 

 

Figure C-1   Excel Window    

Click File->Open menu item to open the Open dialog box, 
select the folder where the file TextEvent.txt is resided, and 
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select the Files of type as Text Files.  Click to select the 
file TextEvent.txt, as shown in Figure C-2. 

 

Figure C-2   Open Dialog Box 

2. Click OK button, a Text Import Wizard dialog box is 
open, as shown in Figure C-3. 

 Figure C-3   Text Import Wizard Dialog Box 
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3. Click Finish button, the dialog box disappears and the 
event data is loaded into the MS-Excel software, as 
shown in Figure C-4. 

Figure C-4   File TextEvent.txt is Open 

4. Click File->Save As  menu item to save the loaded event 
data to a MS-Excel file.  Ensure that in the Save As  
dialog box, the Save as type is Microsoft Excel 
Workbook. 

 

Graphing VRAE Data in Excel  

1. Open the Excel data file that contains the data to be 
graphed by selecting “File” and then “Open.”  Highlight 
the columns that contain the data points.  Make sure that 
the header information is not highlighted. 

2. Go to the “Insert” menu, and under “chart” elect “As New 
Sheet.” 
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3. The first step of the ChartWizard will appear.  In the 
“Range” area, the cells that were highlighted on the chart 
will be denoted.  

 

Press the “Next” button to continue. 

4. The next step will show the different chart types.  For 
this example, the “Line” chart has been selected. 
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Press the “Next” button to continue. 

5. Step 3 of the ChartWizard gives additional choices for 
the line chart, including data markers and gridlines.  In 
this example, number 4 has been selected, so there will 
be markers and gridlines. 

 

Press the “Next” button to continue. 

6. The next step shows a preview of the chart.  This will 
ensure that the correct columns were chosen in the 
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spreadsheet that comprises the chart.  Press the “Next” 
button to continue. 

7. The final step is where the chart title and axis titles may 
be added. After these are added in the spaces provided, 
press the “Finish” button. 

8. A sample of a finished chart is shown on next page.  For 
additional information and other modifications that can 
be made to the Excel chart, please refer to the Excel 
instruction manual. 
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APPENDIX D.  RAE SYSTEMS TECHNICAL NOTES 
 

p TN-102 Facts About PID Measurement 
  
p TN-103 External Datalogger Interface to MiniRAE PID 
  
p TN-104 Partial List of Ionization Potentials 
  
p TN-105 MiniRAE PID Battery Characteristics 
  
p TN-106 Correction Factors, Ionization Potentials, and Calibration 

Characteristics 
  
p TN-108 MiniRAE PLUS PGM-76 and 76IS ProRAE 76 Software 

Upgrade for PGM-75 
  
p TN-109 MiniRAE Professional PID Zero Drift 
  
p TN-112 MiniRAE PLUS Datalogger Data Conversion to Microsoft 

Excel version 5.0 
  
p TN-113 Calibration Procedures for ModuRAE PDM-10A 
  
p TN-114 ToxiRAE Sensor Specifications 
  
p TN-115 ToxiRAE Toxic Gas Monitor (PGM-35) at a Glance 
  
p TN-116 ToxiRAE Oxygen Monitor (PGM-36) at a Glance 
  
p TN-117 ToxiRAE Combustible Gas Monitor (PGM-37) at a 

Glance 
  
p TN-118 Use of RAE PIDs for Soil Headspace Measurements 
  
p TN-119 Calculation of STEL, TWA, Min., Max., and Average 

Values for ToxiRAE PID. 
  
p TN-120 Measuring Correction Factors for Volatile Compounds 

with MiniRAE 7 and ToxiRAE PIDs 
  
p TN-121 CO Sensor Cross-Sensitivity and Removal with Charcoal 

Filter 
  
p TN-122 MiniRAE Compliance with EPA Method 21 
  
p TN-123 Diagnostic Modes for RAE Instruments 
  
p TN 124 PID Lamp Characteristics 
  
 TN 125 Creating Custom Correction Factors and Gas Names  

             for the ToxiRAE PID 
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p TN-126 Interchangeability of Sensors in PGM-35 and PGM-50 
  
p TN-127 Benzene-Specific Measurements in Petroleum  

             Hydrocarbons using the UltraRAE 
  
p TN-128 ToxiRAE PID Communications Problems 
  
p TN-129 Gas Detection Tube and Hand Pump Interchangeability 
  
p TN-130 Setting Alarm Limits for Mixtures 
  
p TN-131 Verifying and Fixing Gas Alarm Limits 
  
p TN-132 Upgrading RAE Instruments Firmware 
  
p TN-133 Methylene Chloride-Specific Measurements using the  

             UltraRAE 
  
p TN-134 UltraRAE Bar Code Reader Patterns an Adjustments 
  
p TN-135 UltraRAE Firmware and Tube Data Upgrade 

             Procedures 
  
p TN-136 UltraRAE Operations Tips 
  
p TN-137 Exiting Diagnostic Mode for ToxiRAE LEL 
  
p TN-138 RAE System Year 2000 Compliance 
  
p TN-139 UltraRAE Communication with NT 
  
p TN-140 Extension Tubing Volume and Delay Time 
  
p TN-141 MultiRAE Remote Control Functions  
  
p TN-142 MiniRAE 2000 Preprogrammed Compound Library 
  
p TN-143 Accuracy Comparisons of Gas Detection Tubes 
  
p TN-144 Handling LEL Sensor Poisoning 
  
p TN-145 Proper Care of Nickel Cadmium Battery Packs 
  
p TN-146 Turning On UV Lamps in a PID Monitor 
  
p TN-147 UltraRAE: Butadiene Specific Monitor 
  
p TN-148 Measurement of Phosphine (PH3) by PID in the Food 

             Storage industry 
  
p TN-149 PGM-30 UV Lamp Care 
  
p TN-150 Understanding the ppbRAE 
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p TN-151 Electrochemical Sensor Replacement and Maintenance 
  
p TN-152 Effects of Operating Conditions on Oxygen Sensors 
  
p TN-153 TC Sensor Applications and Correction Factors 
  
p TN-154 SampleRAE Correction Factors 
  
p TN-155 2-Year Oxygen Sensor Installation and Calibration 
  
p TN-156 Correction Factors for Combustible Gas (LEL) Sensors 
  
p TN-157 Moisture Exchange Tubes for Humidity Control of Test 

             Gases 
  
p TN-158 Conversion of PID Readings to Methane Equivalent 

             Response 
  
p TN-159 Nerve Agent Measurements by PID 
  
p TN-160 Upgrading MultiRAE/QRAE Ni-Cd Battery Pack 
  

 
See Appendix F on how to obtain  

Technical Notes. 
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APPENDIX E.  RAE SYSTEMS APPLICATION NOTES 
 

p AP-200   PIDs and Aircraft Wing-tank Entry 
  
p AP-201   Measuring Ammonia (NH3) with PIDs 
  
p AP-202   ABCs of Gases in Industry  
  
p AP-203   PID as a Hazmat Response Tool 
  
p AP-204   Pulp & Paper:  Measuring Turpentine & ClO2   
p AP-205   Measuring Heat Transfer Fluids with a PID 
  
p AP-206   Guide to Atmospheric Testing in a Confined Space 
  
p AP-207   PIDs as an Arson Investigation Tool 
  
p AP-208   HAZMAT User List 
  
p AP-209   UltraRAE User List 
  
p AP-210   North American RAE Instrument User List 
  
p AP-211   PIDs for Continuous Monitoring of VOCs 
  
p AP-212   PIDs for Indoor Air Quality 
  
p AP-213   ModuRAE PID Configuration and Applications 
  
p AP-214   Environmental Applications for PIDs 
  
p AP-215   Gas Detection in the Marine Industry 
  
p AP-216   Weapons of Mass Destruction 
  
p AP-217   Confined Spaces in the Construction Industry 
  
p AP-218   Lengthening the Interval Between Calibration Checks 
  
p AP-219   Using PIDs for 10% of LEL Decisions 
  
p AP-220   Using PIDs in Clan Lab Investigations 
  
p AP-221   PIDs for Exposure Risk in Unknown Environments 
  
p AP-222   CO & Natural Gas Detection for Fire Department 

               Engine Companies 
  
p AP-223   ppbRAE User List 

See Appendix F on how to obtain Application Notes. 
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APPENDIX F.  LITERATURE REQUEST 
 

Photocopy this page and fax to: 

Attn: Literature Department 

1.408.752.0724 FAX 
Please send me the following information: 

 
 
Name:  

 

 
Company:  

 

 
Mailing Address:  

 

 
City, State, Zip:  

 

 
Country: 

 

Telephone:    

Fax:  

Technical Notes:  
(just list TN #) 

 

Application Notes:  
(just list AP #) 

 

 
Comments: 

 

  

  

  

 
Thank you, 

RAE Systems Sales & Marketing Department
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APPENDIX G.  REQUEST FOR RETURN 
AUTHORIZATION FORM 

 
Need to send your monitor in for repair,  

calibration, service or upgrading? 
 

                             Photocopy this page and fax to: 
                                       1.408.752.0724 
                       You will receive, via fax, an RMA number  

and instructions on how to ship. 
 
 

We must obtain the following information in full: 
 

Name:   

Company:   

Shipping 
Address:  

 

City, State, Zip:   

Telephone:    

Fax:  

Serial number:  

Model:  

Reason for 
return: 

 

  

  

  

Note:  When returning an instrument for repair, please send only the monitor that 
needs to be worked on without any additional accessories.  Only send accessories 
with the instrument when they are also in need of repair.  This will help us get your 
equipment back to you in an efficient manner. 

Thank you, 
RAE Systems Service Department 



 

 

 
RAE Systems Inc. 
1339 Moffett Park Drive 

Sunnyvale, California 94089 
 
 

Main Contact Numbers 
TEL:  408.752.0723 

FAX:  408.752.0724 

 

Toll Free Numbers 
Instrument Sales:  877.RAE.CUSTomer (723.2878) 

Technical Service:  888.RAE.4800 (723.4800) 

Tube Sales:  888.RAE.TUBE (723.8823) 

 

E-mail: 

Instrument Sales:  raesales@raesystems.com 

Technical Service:  tech@raesystems.com 

Tube Sales:  raetubes@raesystems.com 
 
 

World Wide Web Sites: 
www.raesystems.com 

www.raetubes.com 
 

 


